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MOTTO 

 

 

 

 

He who treads a path in search of knowledge, 

 Allah will ease the way to paradise for him 

 (Sahih Muslim) 

 

 

Life isn’t about finding yourself, but life is about creating yourself 

 (Troye Sivan) 
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ABSTRAK 

 Penelitian ini bertujuan untuk menganalisis karakteristik frekuensi 

predominan (𝑓0), faktor amplifikasi (𝐴0), penampang seismik kurva H/V, struktur 

bawah permukaan berdasarkan nilai 𝑉𝑠 dan arah sumber gelombang menggunakan 

H/V Rotate pada kawasan jalur sesar di Kecamatan Bagelen, Kabupaten Purworejo 

menggunakan metode mikroseismik.  

 Penelitian dilakukan di Desa Kalirejo, Clapar, Soko, Sokagung, Semagung, 

Semono, Hargorejo, dan Somorejo yang dibatasi pada koordinat 7°46’40,58’’ - 

7°49’23,99’’ LS dan 110°1’22,65’’ - 110°3’33,46’’ BT. Pengambilan data 

dilakukan menggunakan satu set alat Digital Portable Seismograph merk Taide tipe 

TDL-303S pada 32 titik penelitian dengan spasi 1 Km. Data berupa sinyal 

mikrotremor kemudian diolah dengan metode HVSR pada software Geopsy 

sehingga diperoleh kurva H/V yang menyatakan nilai 𝑓0 dan 𝐴0. Kurva tersebut 

menjadi input dalam pengolahan dengan metode ellipticity curve menggunakan 

software Dinver sehingga diperoleh ground profile yang menyatakan nilai 

kecepatan gelombang geser (𝑉𝑠) beserta kedalamannya. 𝑓0, 𝐴0, dan 𝑉𝑠 digunakan 

untuk membuat penampang seismik kurva H/V. Data sinyal mikrotremor juga 

diolah dengan metode H/V rotate untuk mengetahui arah sumber gelombang. 

 Hasil dari penelitian menunjukkan bahwa nilai 𝑓0 di Kecamatan Bagelen 

berkisar antara 0,77 – 17,43 Hz, nilai 𝐴0 adalah 1,01 – 15,50, nilai 𝑉𝑠 adalah 47,11 

m/s – 3215,25 m/s, dan H/V rotate mengarah ke UTL – SBD  hingga T – B. Hasil 

mikrozonasi dan pemodelan berdasarkan parameter-parameter tersebut 

merepresentasikan kemungkinan adanya tiga jalur sesar pada daerah penelitian. 

Jalur sesar tersebut bukan merupakan jalur sesar yang berkemenerusan melainkan 

berupa segmen-segmen sesar dan bergeser dari garis sesar yang tercantum pada peta 

geologi lembar Yogyakarta. 

 

Kata kunci: sesar, mikroseismik, Kecamatan Bagelen 
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ABSTRACT 

 The research aimed to analyze the characteristics of predominant frequency 

(𝑓0), amplification factor (𝐴0), seismic cross-section of H/V curve, subsurface 

structure and wave source direction of fault area in Bagelen District, Purworejo 

Regency using microseismic method.  

 The research was done in Kalirejo, Clapar, Soko, Sokagung, Semagung, 

Semono, Hargorejo, and Somorejo villages which limited to coordinates of 

7°46'40.58'' - 7°49'23.99'' S and 110°1'22.65 '' - 110°3'33.46'' E. Data was collected 

using a set of Taide TDL-303S Digital Portable Seismograph at 32 research points 

with 1 Km spacing. Data in the form of microtremor signals were then processed 

by HVSR method using Geopsy to obtain the H/V curve that show the value of 𝑓0 

and 𝐴0. The curve became the input for ellipticity curve method in Dinver to obtain 

the ground profile that show the value of shear wave velocity (𝑉𝑠) and layer depth. 

The 𝑓0, 𝐴0 , and 𝑉𝑠 then were used to make seismic cross-section of H/V curve. 

Microtremor signal also processed by H/V Rotate method to obtain the direction of 

the wave’s source. 

The result showed that the value of 𝑓0 in Bagelen district ranged from 0.77–

17.43 Hz, the value of 𝐴0 ranged from 1.01 – 15.50, the value of 𝑉𝑠 ranged from 

47,11 m/s – 3215,25 m/s and H/V Rotate lead to NNE – SSW until E – W. 

Microzonation and modeling based on these parameters represent the possibility of 

three fault lines in the research area. The faults were not a continuous line but in the 

form of segments and shifted from fault line depicted in geological map of 

Yogyakarta. 

 

Keywords: fault, microseismic, Bagelen District 
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BAB I 

PENDAHULUAN 

 

A. Latar Belakang 

Negara Indonesia adalah negara yang secara geografis terletak pada  6°LU 

- 11°LS dan 95°BT - 141°BT, sedangkan secara geologis Indonesia berada di antara  

tiga  lempeng  besar  dunia  yaitu  Lempeng  Eurasia,  Lempeng  IndoAustralia dan 

Lempeng Pasifik. Keadaan tersebut membuat Indonesia mempunyai kondisi 

geologi yang kompleks, salah satunya adalah menculnya efek pergerakan lempeng. 

Efek pergerakan lempeng dapat berupa  tumbukan maupun gesekan yang akan  

menimbulkan  peristiwa yang disebut dengan gempabumi tektonik. Gempa bumi 

adalah peristiwa pelepasan energi secara tiba-tiba yang merupakan salah satu 

sumber yang dapat menimbulkan terjadinya penjalaran gelombang seismik  

(Febriani et al., 2013).   

 

Gambar 1. Peta lempeng tektonik  Indonesia (Hall & Morley, 2004) 
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Berdasarkan Gambar 1, zona selatan Pulau Jawa memiliki tingkat kerawanan 

gempabumi yang cukup tinggi. Hal tersebut dikarenakan zona selatan Pulau Jawa 

masuk pada zona subduksi lempeng Indo-Australia-Eurasia yang terdapat aktivitas 

tumbukan. Selain tingkat kerawanan gempabumi yang tinggi, aktivitas lempeng 

tektonik juga mempengaruhi sesar lokal yang berada di daratan.  

 

 

 

 

 

 

 

 

 

 

Gambar 2. Peta bahaya gempa bumi Kabupaten Purworejo (BPBD, 2014) 

 

Salah satu daerah yang merupakan zona selatan Pulau Jawa adalah 

Purworejo, khususnya Kecamatan Bagelen. Secara administratif Kecamatan 

Bagelen adalah kecamatan di Purworejo yang mempunyai luas ±64 km. Kecamatan 

Bagelen berbatasan langsung dengan Provinsi Daerah Istimewa Yogyakarta, 

tepatnya dengan Kabupaten Kulon Progo. Secara geografis sebagian besar wilayah 

Kecamatan Bagelen merupakan daerah pegunungan yang terbentang dalam 

gugusan Lereng Menoreh, dengan sedikit persawahan dan ladang (Pemerintah 
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Kecamatan Bagelen, 2017). Kecamatan Bagelen terdiri dari 17 desa dan merupakan 

kecamatan yang rawan terhadap bencana alam. 

Berdasarkan Gambar 2, Kecamatan Bagelen masuk dalam tiga kecamatan 

yang rentan terhadap bencana gempa bumi dengan kategori sedang hingga tinggi. 

Tercatat pada tahun 2014 terjadi gempa bumi yang episentrumnya berada dekat 

dengan Kecamatan Bagelen. Gempa bumi yang terjadi di Yogyakarta pada tahun 

2006 juga dirasakan di Kecamatan Bagelen hingga menyebabkan dampak kerugian 

material.  

  

 

Berdasarkan Gambar 3, keadaan geologi di sebagian Kecamatan Bagelen 

terdiri dari empat formasi batuan, yaitu endapan aluvium, Formasi Kebo Butak, 

Formasi Andesit dan Formasi Dasit. Selain itu pada Kecamatan Bagelen juga 

terdapat beberapa dugaan sesar minor yang membentang dari timur ke barat. Sesar 

(fault) merupakan retakan pada batuan yang telah mengalami pergeseran. Apabila 

retakan batuan belum bergerak atau bergeser dinamakan kekar (joint). Sesar dapat 

Gambar 3. Peta geologi lokasi penelitian (Rahardjo et al., 1995) 
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berupa retakan tunggal, membentuk lajur atau zona sesar (fault zone) yang terdiri 

dari sekumpulan retakan (Supartoyo, 2015). Dengan adanya aktivitas tumbukan 

lempeng, suatu daerah menjadi  rawan akan adanya bencana alam yang salah 

satunya adalah gempa bumi. Hal ini akibat aktivitas beberapa sesar lokal di daratan  

(Daryono et al., 2009), sehingga dugaan sesar ini dapat dikaitkan dengan rawannya 

bencana alam yang terjadi pada Kecamatan Bagelen tersebut.  

Berdasarkan ulasan yang telah disampaikan di atas, adanya dugaan beberapa 

sesar minor yang dapat memicu terjadinya bencana berupa gempa bumi akan 

menjadi ancaman tersendiri bagi masyarakat yang tinggal di daerah tersebut. 

Sementara penelitian yang membahas tentang sesar minor pada daerah tersebut 

masih terbatas. Penelitian yang dapat dilakukan untuk menginterpretasikan 

kemungkinan keberadaan jalur sesar minor adalah dengan mengkaji mikrozonasi 

nilai faktor amplifikasi, mikrozonasi nilai frekuensi predominan, analisis kontrol 

struktur penampang seismik kurva H/V, analisis struktur bawah permukaan 

berdasarkaan nilai 𝑉𝑠 dan kontrol struktur pada analisis arah sumber gelombang 

berdasarkan H/V rotate di  kawasan sesar menggunakan data mikrotremor.  

Nilai faktor amplifikasi dan frekuensi predominan dapat diperoleh dari 

analisis hasil pengukuran sinyal  mikrotremor menggunakan metode Horizontal to 

Vertical Spectral Ratio (HVSR). Metode HVSR membandingkan antara komponen 

vertikal dari sinyal dengan komponen horizontal dari sinyal yang diperoleh dari 

pengukuran sinyal mikrotremor (Nakamura, 1989). Hasil dari pengolahan metode 

HVSR dapat diolah lebih lanjut menggunakan metode ellipticity curve untuk 

mendapatkan nilai kecepatan gelombang geser (𝑉𝑠). Gelombang geser merupakan 
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salah satu gelombang badan (body wave) yang arah simpangannya tegak lurus 

terhadap arah rambatnya. Nilai kecepatan gelombang geser ini merupakan salah 

satu parameter yang bisa digunakan untuk merepresentasikan kondisi bawah 

permukaan suatu wilayah  (Kanli, 2011). Hasil dari kurva H/V dan nilai kecepatan 

gelombang geser dapat diolah kembali menjadi penampang seismik kurva H/V. 

Penampang seismik kurva H/V direpresentasikan berdasarkan hubungan antara 

parameter ketebalan lapisan sedimen, yaitu periode predominan (𝑇0) dengan 

kecepatan gelombang geser, sehingga  spektrum dalam domain periode dapat 

diubah dalam domain kedalaman untuk merepresentasikan ketebalan lapisan 

sedimen dan faktor amplifikasi di titik pengukuran (Wibowo et al., 2018).  

Dalam dua dekade terakhir, analisis mikroseismik semakin berkembang 

dalam menemukan aplikasi di teknik seismologi, tidak hanya untuk mengetahui 

kawasan rawan gempa bumi namun juga mengidentifikasi keberadaan sesar. Dalam 

identifikasi sesar ini metode yang digunakan adalah analisis sinyal mikroseismik 

dengan menghitung rasio spektral horizontal-ke-vertikal dan analisis polarisasi 

wavefield yang ada untuk mengetahui arah amplifikasi (H/V rotate). Pengamatan 

ini membuka perspektif baru dalam penggunaan pengukuran sinyal mikrotremor 

yang cepat dan murah untuk memperkirakan orientasi dominan jaringan rekahan di 

zona sesar. 

Sebagian besar penelitian yang menggunakan metode ini tidak 

mengidentifikasi keberadaan sesar. Penelitian-penelitian yang pernah dilakukan 

dengan metode ini di antaranya mengidentifikasi struktur bawah permukaan 

menggunakan metode ellipticity curve di Kecamatan Prambanan dan Kecamatan 
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Gantiwarno Kabupaten Klaten (Patimah, 2017),  intepretasi ketebalan lapisan 

sedimen berdasarkan penampang seismik kurva H/V  di Kota Pacitan Jawa Timur 

(Wibowo et al., 2018), identifikasi sesar di Campo Imperatore  Italia Tengah  

dengan kontrol struktur pada amplifikasi arah gelombang seismik (Pischiutta et al., 

2017). Sementara penelitian yang pernah dilakukan di wilayah Kecamatan Bagelen  

di antaranya zonasi rawan tanah longsor dengan metode analisis GIS (Dewi et 

al.,2017), dan penelitian tentang kerentanan massa batuan dan daerah rawan 

longsor di lahan Kabupaten Purworejo (Sutarno, 2012). Diharapkan penelitian 

menggunakan metode mikroseismik di wilayah Kecamatan Bagelen Kabupaten 

Purworejo ini dapat menambah referensi mengenai interpretasi keberadaan jalur 

sesar minor di wilayah Kecamatan Bagelen Kabupaten Purworejo. 

 

B. Identifikasi Masalah 

Berdasarkan latar belakang yang telah dipaparkan sebelumnya, maka dapat 

diidentifikasi masalah sebagai berikut : 

1. Indonesia merupakan negara yang berada di antara  tiga  lempeng  besar  dunia,  

yaitu  Lempeng  Eurasia,  Lempeng  IndoAustralia dan Lempeng Pasifik 

sehingga banyak mengalami aktivitas lempeng berupa gempabumi. 

2. Zona selatan Pulau Jawa masuk pada zona subduksi lempeng Indo-Australia-

Eurasia yang terdapat aktivitas tumbukan sehingga rawan terhadap gempa bumi. 

3. Kecamatan Bagelen Kabupaten Purworejo merupakan wilayah yang rawan 

bencana alam dan terdapat adanya jalur sesar. 
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4. Belum adanya penelitian mengenai interpretasi keberadaan jalur sesar di 

Kecamatan Bagelen Kabupaten Purworejo menggunakan metode mikroseismik. 

 

C. Batasan Masalah 

Penelitian ini dibatasi sebagai berikut : 

1. Pengambilan data penelitian melingkupi kawasan 3 jalur sesar yang terletak di 

koordinat 7o46’40,58’’ – 7o49’23,99’’ LS dan 110o1’22,65’’ – 110o3’33,46’’ BT 

yang terdiri dari 8 desa, yaitu Desa Kalirejo, Clapar, Soko, Semono, Semagung, 

Hargorejo, Sokoagung, dan Somorejo di Kecamatan Bagelen Kabupaten 

Purworejo. 

2. Data yang digunakan berupa data primer sinyal mikrotremor yang diambil secara 

langsung di lokasi penelitian sebanyak 32 titik. 

3. Pengambilan data mikrotremor menggunakan alat seismograf merek Taide tipe 

TDV-23S dan mengacu pada aturan yang ditetapkan oleh SESAME European 

Research Project.  

 

D. Rumusan masalah  

Rumusan masalah dalam penelitian ini adalah sebagai berikut :  

1. Bagaimana mikrozonasi frekuensi predominan, faktor amplifikasi, dan 

penampang seismik kurva H/V pada kawasan sesar Kecamatan Bagelen 

Kabupaten Purworejo? 
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2. Bagaimana struktur bawah permukaan berdasarkan nilai kecepatan gelombang 

geser pada daerah penelitian? 

3. Bagaimana pola arah sumber gelombang berdasarkan model H/V rotate pada 

kawasan sesar Kecamatan Bagelen Kabupaten Purworejo? 

 

E. Tujuan Penelitian 

Tujuan penelitian ini adalah :  

1. Mengetahui mikrozonasi frekuensi predominan, faktor amplifikasi, dan 

penampang seismik kurva H/V pada kawasan sesar Kecamatan Bagelen 

Kabupaten Purworejo. 

2.  Mengetahui struktur bawah permukaan berdasarkan nilai kecepatan gelombang 

geser pada daerah penelitian. 

3. Mengetahui pola arah sumber gelombang berdasarkan model H/V rotate pada 

kawasan sesar Kecamatan Bagelen Kabupaten Purworejo. 

 

F. Manfaat Penelitian 

Hasil penelitan yang dilakukan diharapkan memberikan manfaat sebagai 

berikut :  

1. Memberikan informasi dan gambaran terkait keberadaan jalur sesar yang 

terletak di kawasan Kecamatan Bagelen Kabupaten Purworejo. 
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2. Informasi terkait keberadaan jalur sesar dapat digunakan sebagai upaya 

peningkatan kewaspadaan bencana yang kemungkinan ditimbulkan oleh 

aktivitas sesar.  

3. Dapat dimanfaatkan sebagai literatur pendukung dalam mendesain tata ruang 

dan dasar pembangunan di kawasan Kecamatan Bagelen Kabupaten Purworejo 

berbasis mitigasi bencana gempa bumi.  

4. Sebagai bahan masukan dan referensi bagi penelitian selanjutnya. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

10 

 

BAB II 

DASAR TEORI 

 

A. Gempa Bumi 

Gempa bumi adalah getaran yang bersumber dari dalam bumi, kemudian 

merambat ke permukaan bumi akibat adanya aktivitas di dalam bumi (Nur, 2010). 

Penyebab gempa bumi bermacam-macam, dapat berupa dinamika bumi (tektonik), 

aktivitas gunungapi (vulkanik), akibat meteor jatuh, longsor, ledakan bom nuklir di 

bawah permukaan dan masih banyak lainnya, namun gempa bumi tektonik 

merupakan gempa bumi yang paling umum terjadi. Gempa tektonik merupakan 

getaran yang dihasilkan dari peristiwa pematahan atau gesekan batuan akibat 

benturan dua lempeng bumi secara perlahan. Energi yang dihasilkan berupa getaran  

yang dipancarkan ke segala arah dalam bentuk gelombang seismik sehingga 

efeknya dapat dirasakan sampai ke permukaan bumi sebagai getaran atau 

guncangan tanah  (BMKG, 2015). 

Permukaan bumi terdiri atas beberapa lempeng tektonik yang merupakan 

bagian dari litosfer padat atau segmen keras kerak bumi. Lempeng tektonik ini 

mengapung di atas astenosfer yang cair dan panas, sehingga lempeng tektonik dapat 

bergerak bebas dan saling berinteraksi. Interaksi tersebut menghasilkan getaran 

yang disebut dengan gempa bumi. Selain pergerakan lempeng, terdapat juga 

patahan pada permukaan bumi yang dapat menyebabkan terjadinya gempa bumi. 

Patahan atau retakan tersebut disebut dengan istilah sesar (fault). 
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B. Sesar (Fault) 

Patahan atau sesar (fault) adalah satu bentuk rekahan atau pergeseran atau 

pergerakan pada lapisan batuan bumi yg memungkinkan satu blok batuan bergerak 

relatif terhadap blok yg lainnya. Pergerakannya bisa relatif turun, relatif naik, 

ataupun bergerak relatif mendatar terhadap blok yang lainnya (Asri, 2006). 

Pergerakan atau pergeseran dapat berkisar beberapa milimeter hingga ratusan 

meter, sedangkan panjangnya dari beberapa meter hingga ribuan kilometer. 

Pergerakan dari suatu patahan atau sesar dapat mengakibatkan gempa bumi. Selain 

itu, pergerakan atau pergeseran sesar juga dapat mengubah topografi, mengontrol 

air permukaan dan bawah permukaan, merusak stratigrafi batuan dan sebagainya. 

Pada umumnya, terbentuknya sesar pada suatu daerah akibat tektonik 

dengan waktu dan tempat yang sama tidaklah tunggal, selalu terjadi lebih dari satu 

jalur sesar dengan ukuran yang bervariasi. Kelompok sesar yang demikian 

dinamakan dengan sistem sesar. Terdapat 3  kelompok sesar utama, yaitu sesar naik, 

sesar normal dan sesar mendatar. 

1. Sesar Naik (Thrust Fault) 

Sesar naik (thrust fault) merupakan sesar dengan hanging wall relatif 

bergerak naik terhadap foot wall. Umumnya sesar naik tidak pernah berdiri sendiri 

atau berkembang tunggal. Sesar selalu membentuk suatu zona, sehingga pada zona 

sesar dijumpai sejumlah bidang sesar. Masing-masing bidang sesar tersebut 

membentuk pola yang sama, yaitu bidang sesar umumnya memiliki arah 

kemiringan yang sama dan arah jalur sesarnya relatif sama. Seperti yang 
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ditunjukkan pada Gambar 4, ciri pada sesar naik adalah lapisan batuan yg berjenis 

sama pada hanging wall berada pada posisi yang lebih atas dari lapisan batuan yang 

sama pada foot wall. Ini menandakan lapisan yang ada di hanging wall bergerak 

relatif naik terhadap foot wall-nya. 

 
Gambar 4. Sesar naik atau thurst fault (Satriadi, 2015) 

 

2. Sesar Normal (Normal Fault) 

Sesar normal (normal fault) dikenali juga sebagai sesar gravitasi, dimana 

gaya gravitasi menjadi gaya utama yang menggerakannya. Sesar normal terbentuk 

akibat adanya tegasan ekstensional, sehingga pada bagian tertentu gaya gravitasi 

lebih dominan. Kondisi ini mengakibatkan beberapa bagian tubuh batuan akan 

bergerak turun yang selanjutnya lazim dikenal sebagai proses pembentukan sesar 

normal. Sesar normal terjadi apabila hanging wall relatif bergerak ke bawah 

terhadap foot wall. Gerak sesar normal ini dapat murni tegak atau disertai oleh gerak 

lateral. Sistem tegasan pembentuk sesar normal adalah ekstensional, dimana posisi 

tegasan utamanya vertikal sedangkan kedudukan tegasan menengah dan minimum 

adalah lateral. Seperti yang ditunjukkan pada Gambar 5, ciri dari sesar normal 

adalah hanging wall relatif turun terhadap foot wall, sehingga lapisan batuan yang 

berjenis sama dengan foot wall akan cenderung lebih turun. 

http://3.bp.blogspot.com/-bRsAnqSHRNM/TvqpjSyaLSI/AAAAAAAAADM/nBA0CAoUqts/s1600/10.jpg
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Gambar 5. Sesar normal atau normal fault (Satriadi, 2015) 

 

3. Sesar Mendatar (Strike-Slip Fault) 

Sesar mendatar (strike-slip fault) adalah sesar yang pembentukannya 

dipengaruhi oleh tegasan kompresi. Posisi tegasan utama pembentuk sesar ini 

adalah horizontal, sama dengan posisi tegasan minimumnya, sedangkan posisi 

tegasan menengah adalah vertikal seperti yang ditunjukkan pada Gambar 6. 

Umumnya bidang sesar mendatar digambarkan sebagai bidang vertikal, sehingga 

istilah hanging wall dan foot wall tidak lazim digunakan di dalam sistem sesar ini. 

Berdasarkan gerak relatifnya, sesar ini dibedakan menjadi sinistral dan dekstral. 

Seperti halnya sesar naik, sesar mendatar pun umumnya tidak berdiri tunggal 

melainkan terdiri dari beberapa bidang sesar yang selanjutnya membentuk zona 

sesar. Di dalam zona sesar mendatar, umumnya sesar ini membentuk segmen-

segmen sesar yang merencong.  

 

          Gambar 6. Sesar mendatar atau strike-slip fault (Satriadi, 2015) 
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C. Gelombang Seismik 

Gelombang gempa atau disebut juga gelombang seismik merupakan 

gelombang yang menjalar di dalam bumi yang disebabkan oleh adanya deformasi 

struktur di bawah bumi akibat adanya tekanan ataupun tarikan karena sifat 

keelastisitasan kerak bumi. Gelombang seismik menyebar ke segala arah dan 

bergerak sangat cepat. Gelombang seismik terkuat berada di wilayah yang dekat 

dengan episenter dan melemah saat gelombang menyebar. Kecepatan gelombang 

seismik dipengaruhi oleh kekakuan (rigiditas) dan kerapatan lapisan sebagai 

medium bagi perambatan gelombang. 

Gelombang seismik dapat diklasifikasikan menjadi dua jenis, yaitu 

gelombang badan (body wave) dan gelombang permukaan (surface wave). Seperti 

ditunjukkan pada Gambar 7, gelombang badan menjalar di dalam bumi sedangkan 

gelombang permukaan menjalar di permukaan bumi.  

 

Gambar 7. Gelombang badan dan gelombang permukaan (Ammon, 2005) 

1. Gelombang Badan 

Gelombang badan merupakan gelombang yang menjalar melalui bagian 

dalam bumi dan menjalar ke segala arah di dalam bumi atau biasa disebut free wave. 



 

15 

 

Berdasarkan gerak partikel pada media dan arah penjalarannya, gelombang ini 

dibagi menjadi 2 macam yaitu : 

a) Gelombang Primer 

Gelombang Primer atau gelombang P terjadi karena adanya tekanan dan  

mempunyai kecepatan rambat gelombang lebih cepat daripada kecepatan rambat 

gelombang S sehingga  akan terdeteksi pertama oleh seismograf. Partikel medium 

saat dilalui gelombang ini bergerak bolak–balik searah dengan arah rambat 

gelombang yang mempengaruhi pergerakan partikel tersebut. Gelombang ini 

disebut juga dengan gelombang longitudinal. Menurut Kayal (2008), kecepatan 

penjalaran gelombang P ditulis dengan persamaan : 

                                        𝑉𝑝 = √
𝑘+

4

3
𝜇

𝜌
                                                    (1) 

dimana 𝑉𝑝 adalah kecepatan gelombang P (m/s), 𝑘 adalah modulus bulk (Pa), 𝜇 

adalah rigiditas atau modulus geser (N/m2), dan 𝜌 adalah densitas atau kerapatan 

material yang dilalui gelombang (Kg/m3). 

b) Gelombang Sekunder 

Gelombang sekunder atau gelombang S merupakan salah satu gelombang 

badan yang memiliki gerak partikel tegak lurus terhadap arah rambatnya, 

gelombang ini disebut juga gelombang transversal. Gelombang ini menjalar lebih 

lambat dibandingkan dengan gelombang primer, tetapi memancarkan energi lebih 

banyak. Kecepatan gelombang S rata-rata 2/3 kali kecepatan gelombang primer 

(Roosa, 2006). Gelombang S hanya dapat merambat pada medium padat. 
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Persamaan penjalaran gelombang S ditulis dengan persamaan (Dentith & Mudge, 

2014): 

                                   𝑉𝑠 = √
𝜇

𝜌
                                                           (2) 

dimana 𝜇 adalah rigiditas atau modulus geser (N/m2) dan 𝜌 adalah densitas atau 

kerapatan material yang dilalui gelombang (kg/m3). 

2. Gelombang Permukaan  

Gelombang permukaan merupakan gelombang yang merambat di 

permukaan bumi. Gelombang ini menjalar lebih lambat daripada gelombang badan, 

namun mengakibatkan kerusakan yang lebih besar. Hal ini dikarenakan gelombang 

permukaan membutuhkan waktu yang lebih lama untuk melewati permukaan bumi. 

Terdapat dua jenis gelombang permukaan yaitu gelombang Rayleigh dan 

gelombang Love. 

a) Gelombang Rayleigh 

Gelombang Rayleigh merupakan salah satu gelombang permukaan yang 

terbentuk dari interferensi antara gelombang P dengan S vertikal dan merambat 

sepanjang free-surface. Orbit gerakan partikelnya berupa gerakan elliptic dengan 

sumbu mayor ellips tegak lurus dengan permukaan dan arah penjalarannya (Telford 

et al., 1990). Gelombang Rayleigh memiliki kecepatan antara 2,0 – 4,2 km/s di 

dalam bumi, dengan besar amplitudonya menurun secara eksponensial sebagai 

fungsi kedalaman (Hidayati, 2010). Kecepatan rambat gelombang Rayleigh ditulis 

dengan persamaan (Elnashai & Sarno, 2008): 
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                                               𝑉𝑟 = 0,92 √𝑉𝑠                                                      (3) 

dimana 𝑉𝑟 adalah kecepatan gelombang Rayleigh (km/s) dan 𝑉𝑠 adalah kecepatan 

gelombang geser (km/s).  

a. Gelombang Love 

Gelombang Love adalah gelombang permukaan yang terdiri dari 

pergerakan parallel gelombang S secara horizontal pada permukaan (Sheriff dan 

Geldart, 1995). Gelombang ini yang menyebabkan tanah mengalami pergeseran 

pada arah horizontal. Gelombang Love mempunyai kecepatan di permukaan bumi 

(𝑉𝐿) sebesar 2,0 km/s hingga 4,4 km/s (Hidayati, 2010). Gelombang ini terbentuk 

akibat interferensi konstruktif dari pantulan-pantulan gelombang seismik pada 

permukaan bebas dan tidak dapat merambat di medium cair. Gelombang ini 

bergerak lebih cepat daripada gelombang Rayleigh (Patimah, 2017).    

D. Mikrotremor 

Mikrotremor adalah getaran tanah yang sangat kecil dan terjadi secara terus 

menerus yang disebabkan oleh aktivitas alam maupun buatan. Aktivitas alam 

dihasilkan dari interaksi seperti angin, arus laut, dan gelombang laut, sedangkan 

aktivitas buatan dihasilkan dari aktivitas manusia seperti lalu lintas, industri, dan 

aktivitas manusia lainnya di permukaan bumi (Arai dan Tokimatsu, 2004). 

Mikrotremor merupakan noise dengan periode pendek yang berasal dari sumber 

artifisial. Gelombang ini bersumber dari segala arah yang saling beresonansi (Lang 

dan Schwarz, 2004). Karakteristik sinyal mikrotremor mencerminkan karakteristik 

batuan di suatu daerah. Penelitian mikrotremor juga banyak dilakukan pada studi 
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struktur tanah (soil investigaton) untuk mengetahui keadaan bawah permukaan 

tanah.  

 

Gambar 8. Contoh data sinyal mikrotremor di Kecamatan Bagelen 

 

Sinyal mikrotremor terdiri dari tiga komponen yaitu dua komponen 

horizontal yaitu spektrum E (Barat-Timur), dan spektrum N (Utara-Selatan) juga 

satu komponen vertikal yaitu spektrum Z seperti pada Gambar 8. Sinyal 

mikrotremor mempunyai amplitudo antara 0,1 μm sampai 1 μm dengan rentang 

periodenya 0,05 sampai 2 detik (Ibrahim dan Subardjo, 2005). Berdasarkan rentang 

periodenya, mikrotremor diklasifikasikan menjadi dua jenis, yaitu periode pendek 

dan periode panjang. Mikrotremor periode pendek berada pada periode kurang dari 

1 detik. Periode ini hanya terkait dengan struktur bawah permukaan yang dangkal. 

Sementara itu, mikrotremor periode panjang berada pada periode lebih dari 1 detik 

dan terkait dengan struktur yang lebih dalam menuju ke dasar batuan keras (Utami, 

2017). Observasi mikrotremor dapat digunakan untuk mengetahui karakteristik 
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lapisan tanah berdasarkan frekuensi predominannya dan faktor penguatan 

gelombangnya (amplifikasi).   

Kegunaan dari survei mikrotremor di antaranya (Putri, 2016): 

• Untuk mengklasifikasikan jenis tanah berdasarkan frekuensi predominan yang 

nilainya spesifik untuk tiap jenis tanah.  

• Mikrotremor tidak hanya digunakan sebagai alat untuk mengantisipasi sifat 

gerakan gempa bumi tetapi juga untuk membuktikan koefisien gaya yang telah 

ditetapkan dalam perencanaan bangunan tahan gempa.  

• Menjelaskan struktur bawah permukaan tanah di tempat survei mikrotremor 

dilakukan. 

 

E. Metode HVSR  

Metode HVSR adalah penentuan rasio sinyal vertikal dengan sinyal 

horizontal yang diperoleh dari pengukuran sinyal mikrotremor pada suatu lokasi 

untuk mengetahui karakteristik dinamis lapisan permukaan (Nakamura, 1989). 

Metode ini adalah metode yang sederhana, sehingga hasil yang didapatkan untuk 

mengetahui kondisi tanah masih bersifat umum. HVSR cukup efektif untuk 

mengkaji karakteristik dinamis lapisan tanah permukaan penyebab terjadinya local 

site effect saat terjadi gempa bumi. Site effect (𝑇𝑆𝐼𝑇𝐸) pada lapisan sedimen 

permukaan ditentukan dengan membandingkan faktor amplifikasi dari gerakan 

horizontal (𝑇𝐻) dengan faktor amplifikasi dari gerakan vertikal (𝑇𝑉) (Daryono et 

al., 2009).  
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                                                     𝑇𝑆𝐼𝑇𝐸 =
𝑇𝐻

𝑇𝑉  
                                                        (4)                           

Besarnya faktor amplifikasi horizontal (𝑇𝐻) yang dirumuskan Nakamura adalah:  

                                                      𝑇𝐻 =
𝑆𝐻𝑆

𝑆𝐻𝐵 
                                                          (5) 

dengan 𝑆𝐻𝑆 adalah spektrum sinyal dari komponen horizontal di permukaan tanah, 

dan 𝑆𝐻𝐵 adalah spektrum dari komponen gerak horizontal pada dasar lapisan tanah.  

Besarnya faktor amplifikasi vertikal (𝑇𝑉) yang dirumuskan Nakamura adalah:   

                                                       𝑇𝑉 =
𝑆𝑉𝑆

𝑆𝑉𝐵 
                                                          (6) 

dengan 𝑆𝑉𝑆 adalah spektrum dari komponen gerak vertikal di permukaan tanah, dan 

𝑆𝑉𝐵 adalah spektrum dari komponen gerak vertikal pada dasar lapisan tanah. Pada 

sinyal mikrotremor, gelombang Rayleigh menjadi gelombang yang mendominasi 

di antara gelombang lainnya. Pengaruh gelombang Rayleigh pada rekaman sinyal 

mikrotremor memiliki besar yang sama untuk komponen vertikal dan horizontal 

saat rentang frekuensi 0,2 Hz – 20,0 Hz, sehingga rasio spektrum komponen 

horizontal dan vertikal di batuan dasar mendekati satu (Bour et al., 1998).  

           
𝑆𝐻𝐵

𝑆𝑉𝐵
 ≈ 1                                                       (7)  

apabila dibulatkan menjadi  

       
𝑆𝐻𝐵

𝑆𝑉𝐵
= 1       atau          

𝑆𝑉𝐵

𝑆𝐻𝐵
 ≈ 1                                                   (8) 

Rasio spektrum antara komponen horizontal dan vertikal di batuan dasar 

mendekati nilai satu. Maka dari itu dengan substitusi persamaan (5), (6), dan (8) ke 
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persamaan (4), akan didapat persamaan (9), persamaan tersebut menjadi dasar 

perhitungan rasio spektrum sinyal mikrotremor komponen horizontal terhadap 

komponen vertikalnya yang dinyatakan dengan  

     𝐻𝑉𝑆𝑅 =  𝑇𝑆𝐼𝑇𝐸 =
𝑆𝐻𝑆

𝑆𝑉𝑆
=

√[(𝑆𝑈𝑇𝐴𝑅𝐴−𝑆𝐸𝐿𝐴𝑇𝐴𝑁)2+(𝑆𝐵𝐴𝑅𝐴𝑇−𝑇𝐼𝑀𝑈𝑅)2]

𝑆𝑉𝐸𝑅𝑇𝐼𝐾𝐴𝐿
              (9) 

Metode HVSR menghasilkan spektrum mikrotremor dengan puncak 

spektrum berada pada frekuensi predominannya. Parameter-parameter yang 

dihasilkan berupa nilai frekuensi predominan (𝑓0) dan faktor amplifikasi (𝐴0) yang 

memberikan informasi mengenai karakteristik dinamis dan struktur lapisan tanah 

(Nakamura, 2000). 

1. Frekuensi Predominan (𝒇𝟎)  

Nilai frekuensi predominan berkaitan dengan kedalaman bidang pantul bagi 

gelombang di bawah permukaan, dimana bidang pantul tersebut merupakan batas 

antara sedimen lepas dengan batuan keras, sehingga semakin kecil frekuensi yang 

terbentuk dari pemantulan gelombang tersebut menunjukkan bahwa semakin tebal 

sedimennya atau semakin dalam bidang pantul gelombang tersebut. Frekuensi 

predominan merupakan nilai frekuensi yang kerap muncul sehingga diakui sebagai 

nilai frekuensi dari lapisan batuan di wilayah tersebut yang dapat menunjukkan 

jenis dan karakteristik batuan tersebut. Nilai frekuensi yang sangat rendah 

meningkatkan kerentanan terhadap guncangan gempa bumi dengan periode yang 

panjang (Putri, 2016). Kanai mengklasifikasi jenis tanah berdasarkan nilai 

frekuensi predominan yang ditunjukkan pada Tabel 1. 
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Tabel 1. Klasifikasi tanah berdasarkan nilai frekuensi predominan mikrotremor 

oleh Kanai (Arifin et al., 2013) 

Klasifikasi Tanah Frekuensi 

Predominan 

(Hz) 

Klasifikasi Kanai Deskripsi 
Tipe Jenis 

Tipe IV 

Jenis I 6,67 – 20 

Batuan tersier atau lebih 
tua, 

terdiri dari batuan hard 

sandy, dan gravel 

Ketebalan sedimen 
permukaannya 

sangat tipis, 

didominasi oleh 

batuan keras 

Jenis II 10 – 4 

Batuan alluvial, dengan 

ketebalan 5m, terdiri dari 

sandy-gravel, sandy hard 

clay, dan loam 

Ketebalan sedimen 
permukaannya 
masuk dalam 

kategori menengah 
5 – 10 meter 

Tipe III Jenis III 2,5 – 4 

Batuan alluvial, dengan 

ketebalan >5m, terdiri dari 

dari sandy-gravel, sandy 

hard clay, dan loam 

Ketebalan sedimen 
permukaan masuk 

dalam kategori 
tebal, sekitar 10 – 

30 meter 

Tipe II Jenis IV < 2,5 

Batuan alluvial, yang 
terbentuk dari sedimentasi 
delta, top soil, dan lumpur, 

dengan kedalaman 30m 
atau lebih 

Ketebalan 

sedimen 

permukaannya 

sangatlah tebal 

 

2. Faktor Amplifikasi  

Faktor amplifikasi gempa bumi adalah faktor pembesaran percepatan 

gempa yang terjadi pada permukaan tanah akibat jenis tanah tertentu. Ketika 

gelombang gempa menjalar dari batuan dasar ke permukaan tanah maka gelombang 

ini akan mengalami amplifikasi. Besaran amplifikasi dapat diestimasi dari kontras 

parameter perambatan gelombang yaitu densitas dan kecepatan pada bedrock dan 

sedimen permukaan. Semakin besar perbedaan parameter tersebut, semakin besar 

pula nilai amplifikasi perambatan gelombangnya (Gosar, 2007). Nilai amplifikasi 
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dipengaruhi oleh variasi formasi geologi, ketebalan dan sifat-sifat fisika lapisan 

tanah dan batuan, seperti batuan mengalami deformasi (pelapukan, pelipatan, dan 

pergeseran) yang mengubah sifat fisik batuan. Pada batuan yang sama nilai 

amplifikasi dapat bervariasi sesuai dengan tingkat deformasi dan pelapukan pada 

tubuh batuan tersebut. 

Klasifikasi faktor amplifikasi menurut Ratdomopurbo (Setiawan, 2009) 

dibagi ke dalam 4 zona yaitu rendah, sedang, tinggi dan sangat tinggi yang 

ditunjukkan pada Tabel 2. 

Tabel 2. Klasifikasi nilai faktor amplifikasi (Setiawan, 2009) 

Zona Klasifikasi Nilai faktor amplifikasi 

1 Rendah A < 3 

2 Sedang 3 ≤ A < 6 

3 Tinggi 6 ≤ A < 9 

4 Sangat tinggi A ≥ 9 

 

 

F. Metode Inversi 

Inverse modelling merupakan suatu metode untuk memperkirakan nilai 

numerik parameter model berdasarkan data hasil observasi  menggunakan model 

tertentu, serta melakukan pencocokan data (data fitting) untuk mencari parameter 

model yang menghasilkan model yang cocok (fit) dengan data pengamatan 

(Patimah, 2017). Salah satu metode dari pemodelan ke belakang adalah metode 

ellipticity curve. Pengolahan data metode ellipticity curve dapat dilakukan 

menggunakan program Dinver pada software Geopsy. Metode ini dipengaruhi oleh 
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beberapa parameter input sebagai inisialisasi awal dari sifat fisis tanah di wilayah 

penelitian. Parameter-parameter tersebut di antaranya 𝑉𝑠, 𝑉𝑝, 𝜌, dan 𝜎 yang 

mempunyai nilai berbeda-beda berdasarkan formasi geologinya. Metode ini 

digunakan untuk mendapatkan parameter kecepatan gelombang geser permukaan 

(𝑉𝑠) di titik pengukuran mikrotremor. 

Inversi gelombang Rayleigh adalah suatu proses yang dilakukan untuk 

mendapatkan parameter-parameter elastis kurva dispersi (ellipticity curve) yang 

tidak diketahui sebelumnya. Tingkat keakuratan dari proses ini dapat dilihat dari 

error (misfit) yang semakin kecil nilai error dari proses iterasi maka profil 

kecepatan gelombang geser yang diperoleh semakin baik. 

1. Poisson Ratio (𝜎) 

Poisson ratio menggambarkan sifat elastisitas batuan yang 

mengindikasikan tingkat rekahan (fracturing) pada batuan tersebut yang mana nilai 

Poisson ratio akan lebih tinggi dari kondisi normal pada batuan yang terisi cairan 

(Manzella, 1990). Persamaan Poisson ratio dapat dituliskan sebagai berikut  

(Telford el al., 1990): 

𝜎 =  
(𝑉𝑝/𝑉𝑠)

2
−2   

2[(𝑉𝑝/𝑉𝑠)
2

 −1]
                                              (10) 

dengan 𝜎 adalah Poisson ratio, 𝑉𝑝 adalah kecepatan gelombang primer (m/s), dan 

𝑉𝑠 adalah kecepatan gelombang geser (m/s). Nilai Poisson ratio untuk material yang 

berbeda ditunjukkan pada Tabel 3. 
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Tabel 3. Harga Poisson ratio dari batuan sedimen (Ostander, 1984) 

Jenis Batuan Poisson Ratio 

Lempung Green River  0,22 – 0,30  

Sedimen Laut Dangkal  0,45 – 0,50  

Sedimen Consolidated :     

Tersaturasi Brine  0,20 – 0,30  

Tersaturasi Gas  0,01 – 0,14  

Batuan Pasir Sintetik :    

Tersaturasi Brine  0,41  

Tersaturasi Gas  0,10  

Batuan Pasir Otawa :    

Tersaturasi Brine  0,41  

Tersaturasi Gas  0,10  

  

2. Densitas (ρ) 

Densitas atau massa jenis merupakan perbandingan antara massa dengan 

volume total. Densitas pada setiap batuan berbeda beda tergantung pada material 

penyusun batuan dan faktor lain. Pada umumnya semakin bertambah kedalaman 

batuan maka densitas juga semakin besar karena tekanan hidrostatik batuan tersebut 

semakin besar. Semakin besarnya tekanan menyebabkan batuan mengalami 

kompresi sehingga semakin rapat lapisan suatu batuan yang menyebabkan semakin 

besar densitas batuan. Besarnya densitas suatu batuan juga bergantung pada 

besarnya porositas suatu batuan. Semakin besar porositas suatu batuan 

mengindikasikan semakin besar pula massa suatu batuan yang hilang atau rongga 

batuan makin besar. Hal ini menyebabkan densitas batuan semakin berkurang 

(Setiawan, 2009). Nilai variasi densitas tiap batuan ditunjukkan pada Tabel 4.  
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Tabel 4. Nilai variasi densitas batuan (Telford et al., 1990)  

Jenis  

Batuan  

Batas 

(Mg/m3)  

Jenis  

Batuan  

Batas 

(Mg/m3)  

Jenis  

Batuan  

Batas 

(Mg/m3)  

Batuan Sedimen Batuan Metamorf Batuan Beku 

Aluvium  1,96-2,00  Schist  2,39-2,90  Riolit  2,35-2,70  

Clay  1,63-2,60  Gneiss  2,59-3,00  Granit  2,50-2,81  

Gravel  1,70-2,40  Phylite  2,68-2,80  Andesit  2,40-2,80  

Silt  1,40-1,93  Slate  2,70-2,90  Synite  2,60-2,95  

Soil  1,80-2,20  Granulite  2,52-2,70  Basalt  2,70-3,30  

Sand  1,20-2,40  Amphibolite  2,90-3,04  Gabro  2,70-3,30  

Sandstone  1,61-2,76  Eclogite  3,20-3,54        

Shale  1,77-3,20              

Limestone  1,93-2,90              

 

3. Kecepatan Gelombang Primer dan Kecepatan Gelombang Sekunder  

Parameter kecepatan gelombang primer (𝑉𝑝) dan kecepatan gelombang 

sekunder (𝑉𝑝) telah dijelaskan pada sub bab sebelumnya yaitu pada sub bab 

gelombang seismik, sedangkan tabel klasifikasi tanah berdasarkan nilai 𝑉𝑝 dan 𝑉𝑠 

ditunjukkan pada Tabel 5, 6, dan 7. 

Tabel 5. Data nilai 𝑉𝑠 pada beberapa jenis batuan (Daryono, 2011) 

Material  Kecepatan Gelombang Geser 𝑽𝒔 m/s) 

Beton  2000  

Granit  3500-380  

Dolerit  2960-3450  

Andesit  2440-3500  

Basal  3600-3700  

Lempung  380-1000  
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Tabel 6. Klasifikasi site berdasarkan nilai 𝑉𝑠 hasil penyelidikan tanah dan  

laboratorium (Badan Standarisasi Nasional, 2012)  

Klasifikasi Site Kecepatan gelombang geser 𝑽𝒔 (m/s) 

Batuan Keras Vs ≥ 1500 

Batuan 750 < Vs ≤ 1500 

Tanah sangat padat dan 

Batuan Lunak 
350 < Vs ≤ 750 

Tanah Sedang 175 < Vs ≤ 350 

Tanah Lunak Vs   < 175 

 

Tabel 7. Data kecepatan gelombang primer pada beberapa medium (Burger, 1992)  

Batuan  Variasi 𝑽𝒑 (m/s)  

Tanah  250 – 600  

Pasir  200 – 1000  

Pasir tersaturasi  800 – 2200  

Pasir dan kerikil  4921 – 6561  

Lempung  1000 – 2500  

Endapan lempung  3281 – 8202  

 

 

G. Penampang Seismik Kurva H/V 

Kurva H/V merupakan kurva yang merepresentasikan kondisi geologi 

setempat berdasarkan respon dinamis getaran alami di permukaan dan bawah 

permukaan (Wibowo et al., 2018). Selain parameter-parameter yang dihasilkan dari 

kurva H/V yaitu frekuensi predominan dan faktor amplifikasi yang dapat 

merepresentasikan kondisi geologi daerah penelitian, kurva H/V juga dapat 

dimanfaatkan sebagai input utama pembuatan penampang seismik. Dengan 
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mengacu persamaan (9) tentang dasar persamaan metode HVSR, maka spektrum 

dalam domain perioda dapat diubah dalam domain kedalaman.  

Gelombang mikrotremor berasal dari fenomena pantulan ganda (multiple 

reflection) gelombang geser, yaitu gelombang seismik yang arah pergerakan 

partikel mediumnya tegak lurus dengan arah pergerakan gelombang. Jika batuan 

pada daerah penelitian dimodelkan dengan media dua lapis sederhana dengan 

litologi permukaan berupa sedimen (tanah lunak) yang mempunyai ketebalan 

tertentu dan kecepatan gelombang geser (𝑉𝑠) maka frekuensi resonansi (𝑓𝑟) dapat 

ditulis dengan persamaan berikut (Wibowo et al., 2018) : 

     𝑓𝑟 = 𝑛 
𝑉𝑠

λ
                                                        (11) 

Frekuensi resonansi yang berkaitan dengan ketebalan sedimen lunak terjadi 

pada fundamental mode (n=1) dan akan berulang pada setiap kelipatan ganjil dari  

λ/4, sehingga persamaan dapat dituliskan sebagai : 

𝑓𝑟 =
𝑉𝑠

λ
 atau  𝑓0 =

𝑉𝑠

4ℎ
                                            (12) 

dengan 𝑓0 adalah frekuensi predominan, ℎ adalah kedalaman dan 𝑉𝑠 adalah 

kecepatan gelombang geser. Bila 𝑓0 dinyatakan dalam perioda predominan (𝑇0) :  

𝑇0 =
4ℎ

𝑉𝑠
                              (13) 

maka kedalaman sedimen dapat dirumuskan dengan persamaan : 

ℎ =
𝑇0 𝑉𝑠

4
          (14) 

Berdasarkan persamaan (14), ketebalan dari sedimen lunak di permukaan 

berkaitan langsung dengan nilai perioda, sehingga spektrum frekuensi harus diubah 
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dalam domain perioda. Picking periode predominan (𝑇0) dilakukan pada puncak 

spektrum HVSR. Dengan mengetahui nilai 𝑉𝑠 pada lokasi penelitian maka dapat 

diketahui kedalaman lapisan sedimen. Bila setiap spektrum dalam satu lintasan 

pengamatan disejajarkan secara vertikal akan terbentuk penampang menyerupai 

penampang seismik seperti yang ditunjukkan pada Gambar 9. 

 
Gambar 9. Sketsa model geologi bawah permukaan dua lapis dan respon 

spektralnya (Wibowo et al., 2018) 

 

H. H/V Rotate 

Dalam dua dekade terakhir, analisis mikroseismik telah menemukan 

aplikasi yang luas dalam teknik seismologi dan gempa bumi, terutama untuk tujuan 

mikrozonasi dan bahaya gempa. Sinyal seismik diproses dengan menghitung rasio 

spektral horizontal-ke-vertikal (HVSR) dan analisis polarisasi wavefield yang ada. 
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Namun dalam beberapa tahun terakhir, telah dikembangkan analisis mikroseismik 

yang dapat memperkirakan orientasi rekahan pada zona sesar. 

Gelombang seismik mengalami peningkatan amplitudo saat merambat dari 

media dengan kerapatan tinggi ke rendah atau dari batuan kaku ke lapisan sedimen. 

Kecepatan gelombang lebih rendah saat melewati tanah lunak atau sedimen dan 

energinya terjebak di antara diskontinuitas bedrock. Adanya batuan yang 

terdeformasi dengan kerapatan retak yang tinggi dan modulus elastisitas yang 

berkurang secara lokal menyebabkan penguatan gelombang seismik di zona sesar 

(Pischiutta et al., 2017), sehingga metode ini membuka perspektif baru dalam 

penggunaan data mikrotremor untuk memperkirakan orientasi dominan jaringan 

rekahan di zona sesar dengan menganalisis sumber arah amplifikasinya. 

Untuk mengetahui arah sumber gelombang, sebuah metode analisis 

diterapkan yang menggabungkan rasio spektral horizontal ke vertikal (HVSR) 

dengan perhitungan sudut polarisasi horizontal dalam domain waktu (Pischiutta et 

al., 2012). Analisis yang dilakukan adalah melakukan perhitungan ulang dengan 

memutar dua komponen horizontal dari 0° sampai 180° dengan interval 10°. Dengan 

cara demikian, HVSR menunjukkan sejauh mana gerakan horizontal diperkuat 

dibandingkan gerakan vertikal, sebagai fungsi frekuensi dan arah gerakan yang 

memungkinkan pendeteksian sumber gelombang. Metode ini disebut juga metode 

H/V rotate.  

Untuk mendapatkan perkiraan lebih lanjut polarisasi gerak tanah horizontal 

secara independen dari komponen vertikal, dapat diterapkan metode matriks 
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kovarians dalam domain waktu dalam bentuk diagram mawar (rose diagram). 

Diagram rose merepresentasikan arah rata-rata polarisasi horizontal gerak di setiap 

stasiun. Diagram rose diplot di setiap stasiun dengan skala dimensi sesuai dengan 

puncak amplitudo HVSR. Hasil dari metode H/V rotate adalah histogram 

melingkar yang mewakili polarisasi horizontal gerakan tanah pada masing-masing 

stasiun. Arah polarisasi diagram rose merepresentasikan adanya deformasi batuan 

yang berupa jalur sesar dengan sudut kira-kira 90° pada sesar normal (normal fault) 

dan sudut lebih kecil yaitu sekitar 60°-70° pada sesar mendatar (strike slip fault). 

     
Gambar 10. Sketsa arah diagram rose dengan zona sesar (Panzera et al., 2014) 

 

I. Geologi Regional Wilayah Penelitian   

Daerah penelitian terletak pada Kecamatan Bagelen Kabupaten Purworejo. 

Secara geografis sebagian besar wilayah Kecamatan Bagelen merupakan daerah 

pegunungan yang terbentang dalam gugusan Lereng Menoreh, dengan sedikit 

persawahan dan ladang (Pemerintah Kecamatan Bagelen, 2017). Kecamatan ini  
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merupakan wilayah Pegunungan Kulon Progo bagian selatan yang merupakan 

bagian dari kompleks Pegunungan Serayu Selatan yang terletak di ujung bagian 

timur. Ujung bagian timur dari Serayu Selatan dibentuk oleh dome yang independen 

dari Gunung Progo Barat (1.022 m) di antara Purworejo dan Sungai Progo di mana 

pada kaki-kaki pegunungan di sekeliling kubah tersebut banyak dijumpai sesar-

sesar yang membentuk pola radial. Daerah penelitian ini merupakan bagian dari 

daerah pengangkatan yang membentuk dome (kubah) yang luas, disebut sebagai 

Oblong dome. Panjang dome (kubah) tersebut sekitar 32 km pada arah utara-

selatan, dan 20 km pada arah barat-timur (Bammelen, 1949).  

Berdasarkan Gambar 3, Kabupaten Purworejo khususnya Kecamatan 

Bagelen merupakan wilayah yang terdiri atas empat formasi batuan. Keempat 

formasi batuan tersebut yaitu: Formasi Aluvium, Formasi Kebo Butak, Formasi 

Andesit, dan Formasi Dasit. 

1. Formasi Aluvium  

Formasi aluvium merupakan formasi termuda yang berumur kuarter. Formasi ini 

terdiri atas kerakal, pasir, lanau, dan lempung sepanjang sungai yang besar dan 

dataran pantai. Formasi Aluvium berupa endapan-endapan serta berhubungan 

dengan aluvium rombakan bahan vulkanik gunung api (Rahardjo et al., 1995). 

2. Formasi Kebo Butak  

Formasi Kebo Butak atau disebut juga Andesit Tua merupakan formasi 

batuan yang diperkirakan berumur oligosen akhir hingga miosen awal. Susunan 

dari formasi ini terdiri dari breksi andesit, tuf, tuf lapili, aglomerat, dan sisipan 
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aliran lava andesit (Rahardjo et al., 1995). Formasi Kebo Butak ini memiliki 

ketebalan mencapai 500 meter dan berada di atas Formasi Nanggulan. Batuan 

penyusun formasi ini berasal dari aktivitas vulkanik di daerah tersebut. Formasi ini 

menyusun Pegunungan Kulon Progo dan merupakan hasil aktivitas dari Gunung 

Api Andesit Tua yang terdiri dari Gunung Gajah di bagian tengah pegunungan, 

Gunung Ijo di bagian selatan serta Gunung Menoreh di bagian utara (Bammelen, 

1949). Formasi ini pada bagian bawah sebagai Kebo Beds yang terdiri atas serpihan 

batu pasir, konglomerat halus, dengan sisipan retas-lempeng (sill) diabas, kemudian 

Butak Beds yang menindih selaras Kebo Beds, disusun oleh aglomerat berselingan 

dengan batu pasir dan serpih. Formasi Kebobutak terbentuk pada Miosen Awal 

hingga Miosen Tengah (Bothe, 1929).  

3. Andesit  

Andesit merupakan batuan terobosan yang diperkirakan memiliki umur 

miosen. Material ini memiliki komposisi andesit hipersten sampai andesit augit 

holenblenda dan trakiandesit (Rahadjo et al., 1995).  

4. Dasit  

Sama halnya dengan Andesit, Dasit merupakan batuan terobosan yang 

diperkirakan juga memiliki umur miosen. Material ini tersusun dari Dasit yang 

menerobos ke Andesit (Rahadjo et al., 1995).  
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BAB III 

METODE PENELITIAN 

 

A. Waktu dan Tempat Penelitian 

Kegiatan studi literatur dan survei telah dilakukan dari bulan Maret 2017 

sampai bulan Agustus 2017 dan pengambilan data dilakukan pada tanggal 6-9 

September 2017. Pengambilan data mikroseismik secara langsung dilakukan di 

kawasan Kecamatan Bagelen Kabupaten Purworejo yang terletak pada koordinat 

geografis 7o46’40,58’’–7o49’23,99’’ LS dan 110o1’22,65’’–110o3’33,46’’ BT. 

Pengambilan data ini mencakup 8 desa yaitu Kalirejo, Clapar, Hargorejo, Soko, 

Semagung, Semono, Sokoagung, dan Somorejo.  

 

B. Alat dan Bahan  

Alat yang digunakan dalam penelitian ini berupa perangkat keras dan 

perangkat lunak. Adapun perangkatnya adalah sebagai berikut:  

1. Perangkat keras (Hardware)  

Perangkat keras yang digunakan dalam penelitian ini antara lain : 

a. Seismograph 

Seismograph merupakan instrumen yang digunakan sebagai alat perekam 

sinyal seismik. Seismograph yang digunakan dalam penelitian ini adalah Digital 

Portable Seismograph yang terdiri dari seismometer, digitizer, antena GPS, dan 
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kabel penghubung. Sketsa rangkaian alat saat pengambilan data ditunjukkan 

pada Gambar 12. 

1) Seismometer merk Taide tipe TDV-23S. 

Seismometer merupakan instrumen yang digunakan untuk merekam 

getaran tanah yang dihasilkan oleh sumber alami dan buatan seperti yang 

ditunjukkan pada Gambar 11(a). Seismometer memiliki tiga detektor yang 

terletak di bagian bawah seismometer untuk mendeteksi getaran tanah 

(Meyers, 2011). 

2) Digitizer merk Taide tipe TDL-303S 

Digitizer yang terhubung pada seismometer berfungsi untuk mengubah 

sinyal analog menjadi sinyal digital. Digitizer ditunjukkan pada Gambar 

11(b). 

3) Antena GPS 

Antena GPS yang ditunjukkan pada Gambar 11(c) terhubung ke digitizer 

yang berfungsi untuk menerima data lokasi dan waktu dari satelit. 

4) Kabel penghubung  

Kabel penghubung berfungsi untuk menghubungkan seismometer, 

digitizer dan laptop yang ditunjukkan pada Gambar 11(d).  

 

b. Laptop yang berfungsi untuk merekam data mikrotremor yang dihubungkan 

dengan digitizer. 

c. Global Positioning System (GPS) merk Garmin tipe 78S digunakan untuk 

menentukan posisi pada setiap titik penelitian, dan untuk menandai koordinat 

lokasi.           
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d. Peta Geologi Regional Yogyakarta dan Sekitarnya yang digunakan sebagai 

bahan analisis geologi.  

e. Kompas digunakan untuk menentukan arah pada saat memasang seismometer.  

f. UPS sebanyak tiga unit yang digunakan sebagai sumber baterai jika baterai 

digitizer habis. 

g. Lembar check list survey mikrotremor yang digunakan untuk mencatat keadaan 

lingkungan pada saat melakukan pengambilan data.  

h. Sekop yang digunakan untuk meratakan tanah sebelum meletakkan sensor. 

i. Camera ponsel digunakan untuk dokumentasi.  

j. Sel surya digunakan untuk cadangan jika baterai digitizer dan UPS habis. 

 

  
             (b) 

                                       
                      (c)                         (d) 

Gambar 11. Set alat Digital Portable Seismograph (a) Seismometer merk Taide tipe 

TDV-23S, (b) Digitizer merk Taide tipe TDL-303S, (c) Antena GPS, 

(d) Kabel penghubung. 

(a) 
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Gambar 12. Rangkaian alat pengambilan data (Wibowo et al., 2018) 

 

2. Perangkat Lunak (software) 

Perangkat lunak yang digunakan dalam penelitian ini antara lain : 

a. Google Earth digunakan untuk memperkirakan kondisi lokasi penelitian dan 

menentukan titik pengambilan data. 

b. Global Mapper 13 dari Blue Marble Geographics digunakan untuk memasukkan 

titik koordinat penelitian ke GPS dan memotong peta. 

c. Sesarray Geopsy versi 2.9.1 digunakan untuk mengolah data sinyal mikrotremor 

sehingga didapatkan kurva H/V dan H/V rotate. 

d. Program Dinver pada software Sesarray Geopsy digunakan untuk menganalisis 

kurva H/V menggunakan metode ellipticity curve (inversi gelombang Rayleigh) 

untuk mendapatkan nilai 𝑉𝑠.  

e. Surfer 11 digunakan untuk membuat rancangan desain survei maupun membuat 

mikrozonasi.   

f. Rockwork 16 digunakan untuk modelling 3D struktur bawah permukaan pada 

titik penelitian dan penggambaran arah amplifikasi dengan diagram rose. 

g. Excel digunakan untuk membuat grafik penampang seismik kurva H/V. 

  

  
  
  
  
  
  
  
  
  
  
  
  
  

1. Seismometer 

2. Digitizer 

3. Kabel penghubung 

4. GPS 

5. Sel surya 
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C. Teknik Pengambilan Data 

1. Tahap Pembuatan Desain Survei 

Pada tahap ini dilakukan survei lapangan ke daerah yang akan dilakukan 

penelitian yaitu Kecamatan Bagelen Kabupaten Purworejo dengan tujuan untuk 

mengetahui kondisi daerah penelitian dan mencari informasi terkait daerah 

penelitian seperti data administrasi, data kejadian bencana dan sebagainya. 

Selanjutnya membuat desain survei yang mencakup tiga sesar yang terdiri dari 

empat formasi yang berbeda-beda sehingga ditetapkan jumlah titik penelitian 

sebanyak 30 titik dengan jarak antar titik 1 km yang ditunjukkan pada Gambar 13.  

 

Gambar 13. Desain survei titik pengambilan data di Kecamatan Bagelen Kabupaten 

Purworejo 

 

2. Survei Lokasi  

Tahap selanjutnya setelah menentukan desain survei adalah melakukan 

survei lokasi. Survei ini dilakukan dengan tujuan untuk mengetahui keadaan lokasi 

yang akan digunakan untuk pengambilan data mikrotremor dan mengetahui medan 
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yang dilalui agar lebih efisien saat pengambilan data. Setelah dilakukan survei 

lokasi, terdapat beberapa pergeseran titik lokasi penelitian  dan penambahan titik 

lokasi penelitian dari desain awal. Hal ini dikarenakan pada desain awal terdapat 

beberapa lokasi titik penelitian yang tidak dapat dijangkau seperti bukit dan jurang, 

titik yang terletak di jalan atau di dekat tambang pasir sehingga dapat menyebabkan 

noise, titik yang terletak di sungai dan titik yang terletak di rumah warga. Desain 

survei setelah dilakukan survei lokasi menjadi 32 titik dengan titik lokasi penelitian 

ditunjukkan pada Gambar 14. 

    

Gambar 14. Titik pengambilan data di Kecamatan Bagelen Kabupaten Purworejo 

 

 

3. Pengambilan Data di Titik Penelitian  

Pengambilan data dilakukan pada semua titik penelitian sebanyak 32 titik   

dengan frekuensi sampling 100 Hz selama ± 30 menit. Durasi tersebut mengacu 

pada durasi pengukuran yang disarankan oleh SESAME (2004) yang ditunjukkan 

pada Tabel 8. Namun pengambilan data lebih dari 30 menit dilakukan pada 

beberapa titik yang berlokasi di tempat yang terdapat banyak noise.  
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Tabel 8. Persyaratan teknis survei mikrotremor di lapangan ( SESAME, 2004). 

 

Jenis parameter   Saran yang dianjurkan   

Durasi pencatatan   

fg minimum yang 

diharapkan (Hz)  

Durasi pencatatan minimum 

yang disarankan (menit) 

0,2  30  

0,5  20  

1  10  

2  5  

5  3  

10  2  

Coupling soilsensor 

alami (insitu)   

• Tempatkan sensor langsung pada permukaan tanah   

• Hindari menempatkan sensor seismograf pada permukaan 

tanah lunak (lumpur, semak-semak) atau tanah lunak 

setelah hujan.   

Coupling soilsensor 

buatan atau artifisial   

• Hindari lempengan yang terbuat dari material lunak seperti 

karet atau busa.   

• Pada kemiringan yang curam di mana sulit mendapatkan 

kedataran sensor yang baik, pasang sensor dalam timbunan 

pasir atau wadah yang diisi pasir.   

Keberadaan 

bangunan atau 

pohon   

• Hindari pengukuran dekat dengan bangunan, gedung 

bertingkat, dan pohon yang tinggi, jika tiupan angin di atas 

± 5 m/detik. Kondisi ini sangat mempengaruhi hasil analisa  

HVSR yang ditunjukkan dengan kemunculan frekuensi 

rendah pada kurva.   

• Hindari pengukuran di lokasi tempat parkiran, pipa air dan 

gorong-gorong.   

Kondisi Cuaca   

• Angin: Lindungi sensor dari angin (lebih cepat dari 5 m/s).   

• Hujan: Hindari pengukuran pada saat hujan lebat. Hujan 

ringan tidak memberikan gangguan berarti.   

• Suhu: Mengecek kondisi sensor dan mengikuti instruksi 

pabrik.   

Gangguan   

• Sumber monokromatik: hindari pengukuran mikrotremor 

dekat dengan mesin, industri, pompa air, generator yang 

sedang beroperasi.   

• Sumber sementara: jika terdapat sumber getar transient 

(jejak langkah kaki, mobil lewat, motor lewat) tingkatkan 

durasi pengukuran untuk memberikan jendela yang cukup 

untuk analisis setelah gangguan tersebut hilang.   
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Hasil dari pengukuran secara otomatis tersimpan pada digitizer berupa data 

mentah sinyal getaran mikrotremor dalam fungsi waktu yang dapat ditampilkan 

pada laptop menggunakan software Monost. Sinyal  getaran ini terdiri dari 3 

komponen, yaitu 2 komponen horizontal dan 1 komponen vertikal. Komponen 

horizontal terdiri dari sinyal North-South dan sinyal East-West, sedangkan 

komponen vertikal merupakan sinyal getaran Up and Down.  

 

D. Teknik Analisis Data  

Teknis analisis data dilakukan beberapa tahap yaitu : 

1. Analisis Sinyal Mikrotremor  

                    
(a)                                                          (b) 

Gambar 15. (a) Kurva H/V sebagai fungsi frekuensi dan faktor amplifikasi (b) 

Kurva H/V Rotate 

 

Sinyal mikrotremor yang didapat dari hasil pengukuran dianalisis 

menggunakan software Sesarray Geopsy. Selanjutnya dilakukan proses windowing 

yaitu pemilihan sinyal tanpa noise dan cutting yaitu memotong sinyal untuk 

dianalisis menggunakan metode HVSR sehingga didapatkan kurva H/V seperti 
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pada Gambar 15(a). Dari kurva H/V didapatkan nilai frekuensi predominan 

(𝑓0) dan nilai faktor amplifikasi (𝐴0). Selain itu sinyal mikrotremor dari hasil 

cutting juga dianalisis menggunakan H/V Rotate agar didapat nilai amplifikasi 

beserta arahnya dalam derajat yang ditunjukkan pada Gambar 15(b). 

 

2. Mikozonasi Nilai Frekuensi Predominan (𝑓0) dan Faktor Amplifikasi (𝐴0) 

Nilai frekuensi predominan dan faktor amplifikasi yang didapat dari kurva 

H/V pada setiap titiknya menjadi input untuk membuat mikrozonasi atau pemetaan. 

Dalam pembuatan mikrozonasi digunakan software Surfer dengan mengoverlay 

titik koordinat, nilai 𝑓0 atau 𝐴0, peta topografi dan koordinat sesar. Hasil dari 

mikrozonasi berupa contour warna pada lokasi penelitian yang menggambarkan 

nilai 𝑓0 ataupun 𝐴0. 

 

3. Analisis Penampang Seismik Kurva H/V 

Penampang seismik didapat dari hasil analisis menggunakan kurva H/V 

sebagai input utama. Data 𝑓0 dan 𝐴0 yang didapat dari kurva H/V dan nilai 𝑉𝑠 dari 

hasil analisis menggunakan metode ellipticity curve menjadi data input. Data 𝑓0 

diubah menjadi 𝑇0 selanjutnya dianalisis dengan mengacu pada persamaan (14), 

domain periode dapat diubah menjadi domain kedalaman. Hasil dari analisis 

masing-masing titik penelitian digabung menjadi lintasan penampang seismik. 

Lintasan ini dibuat dengan melakukan penyayatan titik-titik penelitian yang 

berpotongan dengan sesar seperti pada Gambar 16, sehingga memudahkan dalam 

mengidentifikasi sesar pada lintasan penampang seismik tersebut. Hasil dari 
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penggabungan kurva H/V yang membentuk sebuah penampang dalam lintasan 

ditunjukkan pada Gambar 17.  

 
Gambar 16. Sayatan jalur penampang seismik kurva H/V 

 

 
Gambar 17. Lintasan penampang seismik kurva H/V pada daerah penelitian 

 

4. Analisis Lapisan Bawah Permukaan dengan Metode Ellipticity Curve 

 

Hasil pengolahan sinyal mikrotremor dengan metode HVSR disimpan 

dalam bentuk .hv yang selanjutnya dianalisis menggunakan program Dinver pada 

software Sesarray Geopsy dengan metode ellipticity curve. Selain kurva H/V, 
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terdapat parameter model awal yang menjadi masukan dalam pengolahan ini. 

Parameter tersebut meliputi nilai kecepatan gelombang P (𝑉𝑝), kecepatan 

gelombang S (𝑉𝑠), Poisson ratio, dan massa jenis (densitas) batuan yang ditentukan 

berdasarkan informasi geologi daerah penelitian. Hasil pengolahan ini berupa 

ground profiles kecepatan gelombang geser (𝑉𝑠) dengan variasi model yang 

mempunyai nilai misfit (ketidakcocokan) yang berbeda-beda. Model dengan nilai 

misfit terendah akan digunakan sebagai model terbaik. Nilai 𝑉𝑠 dan kedalamannya 

pada setiap lapisan menjadi data input dalam pengolahan selanjutnya. Hasil analisis 

menggunakan program Dinver ditunjukkan pada Gambar 18. 

                 

(a)                                                            (b) 

Gambar 18. (a) Ellipticity curve dengan garis hitam adalah model terbaik (b) 

Ground profiles 𝑉𝑠 

 

5. Pemodelan 3D Struktur Bawah Permukaan Berdasar Nilai 𝑉𝑠 Menggunakan 

Software Rockwork 16 

Data nilai kecepatan gelombang geser (𝑉𝑠) dan kedalamannya yang didapat 

dari ground profiles hasil pengolahan menggunakan metode ellipticity curve 

digunakan sebagai input pemodelan 3D menggunakan software RockWork 16. 

Pemodelan ini akan mempermudah dalam mengidentifikasi sesar dengan 
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menganalisis struktur bawah permukaannya. Penyayatan solid model secara 

vertikal juga dilakukan untuk memudahkan dalam mengidentifikasi sesar secara 

lebih detail. 

 

6. Analisis H/V Rotate di Kawasan Sesar 

Hasil pengolahan sinyal mikrotremor menggunakan H/V rotate pada 

software Sesarray Geopsy disimpan dalam bentuk .txt dan dibuka pada software 

Excel untuk mendapatkan data nilai amplifikasi dan nilai derajat azimutnya. Data 

dengan nilai amplifikasi tinggi beserta nilai derajat azimutnya akan menjadi input 

untuk pengolahan selanjutnya yaitu pengolahan diagram rose. Diagram rose yang 

dihasilkan pada pengolahan menggunakan software Rockwork 16 dapat 

memudahkan dalam merepresentasikan arah sumber gelombang. Pembacaan arah 

dari diagram rose pada tiap titik menggunakan 16 arah mata angin agar lebih 

terspesifikasi arahnya, 16 arah tersebut ditunjukkan pada Gambar 19. Diagram rose 

pada setiap titik penelitian yang terletak di kawasan sesar kemudian dipetakan agar 

terlihat polanya.  

 
Gambar 19. Nama 16 arah mata angin beserta derajatnya 
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E. Diagram Alir Penelitian 

Diagram alir penelitian ini ditunjukkan pada Gambar 20.  
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BAB IV 

HASIL DAN PEMBAHASAN 

 

Lokasi penelitian ini berada pada Kecamatan Bagelen Kabupaten Purworejo 

yang merupakan daerah pegunungan yang terbentang dalam gugusan Lereng 

Menoreh. Secara fisiografi, daerah penelitian merupakan bagian dari daerah 

pengangkatan yang membentuk dome (kubah) yang luas, disebut sebagai oblong 

dome. Kondisi geologi lokasi penelitian terdiri dari empat formasi batuan, yaitu 

endapan Aluvium, Formasi Kebo Butak, Formasi Andesit dan Formasi Dasit. 

Selain formasi batuan yang kompleks, pada lokasi penelitian juga terdapat 3 dugaan 

jalur sesar minor yang saling sejajar membentang dari timur ke barat. Ketiga sesar 

ini tepatnya berada pada Desa Kalirejo, Clapar, Hargorejo, Soko, Semagung, 

Sokoagung, Semono, dan Somorejo.  

Identifikasi kemungkinan adanya ketiga jalur sesar tersebut dikaji dengan 

metode mikroseismik yaitu dengan melakukan karakterisasi sinyal mikrotremor 

pada kawasan sesar menggunakan beberapa parameter. Parameter tersebut adalah 

frekuensi predominan (𝑓0), faktor amplifikasi (𝐴0), nilai kecepatan gelombang 

geser (𝑉𝑠), arah sumber gelombang dan penampang seismik. Parameter-parameter 

tersebut dikembangkan menjadi model yang dapat dianalisis dan dapat 

diinterpretasikan kemungkinan adanya ketiga sesar di lokasi penelitian.  
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A. Mikrozonasi Frekuensi Predominan (𝒇𝟎), Faktor Amplifikasi (𝑨𝟎) dan 

Penampang Seismik Kurva H/V 

 

Frekuensi predominan dan faktor amplifikasi merupakan parameter 

berdasarkan kurva H/V yang dihasilkan dari pengolahan sinyal mikrotremor 

dengan metode HVSR (Horizontal to Vertical Spectral Ratio). Kurva H/V 

mempunyai kriteria yang merujuk pada standar yang ditetapkan dalam SESAME 

European Research Project. Kriteria tersebut berupa kriteria reliable dan clear 

peak (SESAME, 2004). Kriteria reliable dan clear peak dikaji dari hasil 

pengolahan metode HVSR di tiap titik penelitian untuk mengetahui apakah kurva 

H/V hasil pengolahan memenuhi standar berdasarkan SESAME European 

Research Project. Kriteria reliable dan clear peak pada masing-masing titik 

penelitian ditunjukkan pada Lampiran 1. Informasi yang diperoleh dari kurva H/V 

seperti pada Gambar 15(a) dapat merepresentasikan kondisi geologi setempat 

dalam bentuk parameter frekuensi predominan dan faktor amplifikasi. Nilai 

frekuensi predominan dan faktor amplifikasi pada setiap titik penelitian dapat 

dibuat peta mikrozonasi.  

1. Mikrozonasi Frekuensi Predominan (𝒇𝟎)  

Frekuensi predominan merupakan parameter yang mencerminkan kondisi 

fisik tanah. Nilai frekuensi predominan berkaitan dengan kedalaman bidang pantul 

suatu gelombang di bawah permukaan. Bidang pantul tersebut merupakan batas 

antara sedimen dengan batuan keras. Nilai frekuensi predominan yang tinggi 

menggambarkan sedimen pada daerah tersebut tipis, sedangkan nilai frekuensi 

predominan rendah mengindikasikan sedimen atau tanah lunak pada daerah 
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tersebut tebal (Pratama, 2017). Mikrozonasi frekuensi predominan disajikan 

menjadi tiga bagian berdasarkan daerah sesar, yaitu sesar utara pada Gambar 21, 

sesar tengah pada Gambar 22, dan sesar selatan pada Gambar 23. 

 

Gambar 21. Mikrozonasi nilai 𝑓0 pada kawasan sesar utara daerah penelitian 

Nilai frekuensi predominan pada kawasan sesar utara cenderung lebih tinggi 

dibandingkan daerah sekitarnya. Persebaran nilai frekuensi predominan pada 

kawasan tersebut bervariasi dengan range nilai 4,67Hz - 13,97 Hz. Berdasarkan 

klasifikasi Kanai pada Tabel 1, nilai frekuensi predominan yang digambarkan 

dengan warna hijau pada peta mikrozonasi tergolong pada tanah jenis II yang 

ketebalan sedimen permukaannya masuk dalam kategori menengah yaitu 5 – 10 

meter. Area tersebut merupakan endapan Aluvium yang terdiri dari kerakal, kerikil, 

pasir dan lumpur. Area tengah jalur sesar utara mempunyai nilai frekuensi 

predominan yang lebih tinggi dibanding daerah sekitarnya yang divisualisasikan 

dengan warna cream hingga orange. Berdasarkan klasifikasi Kanai, area tersebut 

tergolong pada tanah jenis I yang mempunyai ketebalan sedimen sangat tipis dan 
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didominasi oleh batuan keras. Pada peta geologi, area tersebut berada pada Formasi 

Kebobutak yang terdiri dari batuan tuff, aglomerat, lava andesit dan breksi andesit. 

Batuan-batuan tersebut merupakan batuan dengan umur yang berbeda-beda. Area 

tersebut terletak pada topografi yang tinggi sehingga sedimen pada kawasan 

tersebut tipis.  

 

Gambar 22. Mikrozonasi nilai 𝑓0 pada kawasan sesar tengah daerah penelitian 

 

Pola persebaran nilai frekuensi predominan pada kawasan sesar tengah 

daerah penelitian bervariasi dengan range nilai yang besar yaitu 0,78 Hz - 17,43 

Hz. Berdasarkan klasifikasi Kanai, area titik 39 yang digambarkan dengan warna 

biru hingga biru kehijauan tergolong dalam tanah jenis IV dimana ketebalan 

sedimennya sangat besar yaitu lebih dari 30 m. Area ini berada pada Formasi 

Kebobutak dan Aluvium dengan topografi yang datar. Area titik 23, dan area titik 

54 tergolong dalam tanah jenis I yang ketebalan sedimennya sangat tipis. Area ini 

berada pada Formasi Andesit. Formasi Andesit merupakan intrusi batuan yang 



 

51 

 

tergolong dalam batuan keras sehingga nilai frekuensi predominan cenderung 

tinggi dan sedimen permukaannya tipis.  

Terdapat perbedaan nilai frekuensi predominan yang signifikan antara area 

utara jalur sesar bagian barat dengan area selatan jalur sesar bagian barat. Hal ini 

menandakan adanya perbedaan kedalaman lapisan di bawahnya, sehingga 

dimungkinkan adanya patahan atau sesar di antara kedua kawasan tersebut.  

 

Gambar 23. Mikrozonasi nilai 𝑓0 pada kawasan sesar selatan daerah penelitian 

 

Persebaran nilai frekuensi predominan pada kawasan sesar selatan 

mempunyai range 4,34 – 17, 44 Hz. Berdasarkan klasifikasi Kanai, area titik 23 

tergolong dalam tanah jenis I yaitu ketebalan sedimennya sangat tipis. Titik ini 

berada di tengah antara sesar tengah dan sesar selatan. Area titik 5 dan titik 16 

tergolong dalam tanah jenis II dimana ketebalan sedimen pada jenis tanah ini adalah 

5 – 10 meter. Area tersebut berada pada batuan Dasit yang merupakan batuan intrusi 

atau terobosan dari batuan di sekitarnya. Batuan ini merupakan batuan keras yang 

mempunyai umur lebih muda dibandingkan batuan sekitarnya yang seharusnya 
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mempunyai ketebalan sedimen sangat tipis, sehingga adanya sedimen yang cukup 

tebal pada area tersebut bisa diduga disebabkan oleh terjadinya pelapukan pada 

batuan. 

Persebaran nilai frekuensi predominan di kawasan jalur sesar selatan 

menunjukkan perbedaan yang signifikan antara area sebelah utara jalur sesar dan 

area sebelah selatan jalur sesar. Perbedaan nilai frekuensi predominan ini 

menunjukkan ketebalan sedimen yang berbeda secara signifikan sehingga dapat 

dimungkinkan adanya keberadaan jalur sesar pada kawasan tersebut. 

 

2. Mikrozonasi Faktor Amplifikasi (𝑨𝟎) 

Faktor amplifikasi (𝐴0) merupakan parameter yang didapat dari pengolahan 

sinyal mikroseismik dengan metode HVSR. Faktor amplifikasi berhubungan 

dengan kerapatan batuan. Faktor amplifikasi berbanding terbalik dengan kecepatan 

gelombang geser (𝑉𝑠), dimana semakin kecil kecepatan gelombang maka faktor 

amplifikasi semakin besar. Nilai amplifikasi dipengaruhi oleh variasi formasi 

geologi, ketebalan dan sifat-sifat fisika lapisan tanah dan batuan, seperti batuan 

mengalami deformasi (pelapukan, pelipatan, dan pergeseran) yang mengubah sifat 

fisik batuan, sehingga adanya patahan atau sesar dapat mempengaruhi nilai 

amplifikasi (Partono et al., 2013). Mikrozonasi faktor amplifikasi disajikan dalam 

tiga bagian berdasarkan kawasan sesar yaitu sesar utara pada Gambar 24, sesar 

tengah pada Gambar 25, dan sesar selatan pada Gambar 26. 

Gambar 24 merupakan mikrozonasi nilai faktor amplifikasi pada kawasan 

sesar utara di daerah penelitian dengan persebaran yang bervariasi dari 2,76 – 11,21. 
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Area titik 77 dan 93 yang digambarkan dengan contour warna cream memiliki nilai 

faktor amplifikasi 9,55 - 11,21. Berdasarkan klasifikasi Ratdomopurbo yang 

ditunjukkan pada Tabel 2, area tersebut termasuk pada klasifikasi sangat tinggi 

(𝐴0 ≥ 9). Kawasan tersebut sangat rentan jika terjadi gempa bumi, dimana 

gelombang yang merambat dari sumber akan diperbesar saat mencapai permukaan. 

Pada pembahasan mikrozonasi frekuensi predominan, area titik 77 mempunyai 

sedimen yang sangat tipis dan didominasi oleh batuan keras, sehingga nilai faktor 

amplifikasi yang tinggi kemungkinan disebabkan karena batuan mengalami 

perubahan fisik akibat adanya patahan atau sesar.  

 

Gambar 24. Mikrozonasi nilai 𝐴0 pada kawasan sesar utara daerah penelitian 

 

Gambar 25 merupakan mikrozonasi faktor amplifikasi pada kawasan sesar 

tengah di daerah penelitian dengan persebaran nilai faktor amplifikasi yang 

bervariasi dan range yang signifikan yaitu 1,02 – 15,05. Area titik 21 dan 23 yang 

berada di selatan jalur sesar mempunyai nilai faktor amplifikasi 10,65 – 15,50. Area 

tersebut tergolong dalam kategori sangat tinggi. Area titik 54 juga tergolong dalam 
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kategori sangat tinggi dengan nilai faktor amplifikasi 11,71, sedangkan area titik 39 

dan 41 tergolong dalam kategori rendah dengan nilai faktor amplifikasi 1,02 – 2,96. 

Pola persebaran nilai ini hampir sama dengan persebaran nilai frekuensi 

predominannya dimana area utara jalur sesar bagian barat dengan area selatan jalur 

sesar bagian barat mempunyai perbedaan nilai yang signifikan, sedangkan kedua 

area ini berada pada formasi yang sama yaitu Formasi Kebobutak, sehingga 

dimungkinkan terdapat adanya jalur sesar pada area tersebut.  

 

Gambar 25. Mikrozonasi nilai 𝐴0 pada kawasan sesar tengah daerah penelitian 

 

Gambar 26 merupakan mikrozonasi nilai faktor amplifikasi pada kawasan 

sesar selatan daerah penelitian dengan persebaran nilai yang bervariasi dan range 

yang cukup signifikan yaitu 2,97 – 15,51. Area titik 21 dan S23 yang tergolong 

dalam kategori sangat tinggi berada di utara sesar dimana area tersebut termasuk 

dalam Formasi Kebobutak. Daerah selatan sesar pada area titik 5 tergolong dalam 

kategori rendah. Area tersebut terletak pada batuan Dasit, dimana Dasit merupakan 

intrusi atau terobosan batuan berupa batuan keras sehingga kerapatan batuannya 
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tinggi sehingga nilai faktor amplifikasinya rendah. Pada kawasan sesar ini, tidak 

terlihat dengan jelas adanya pola persebaran yang merepresentasikan kemungkinan 

adanya jalur sesar. 

 

Gambar 26. Mikrozonasi nilai 𝐴0 pada kawasan sesar selatan daerah penelitian 

 

Beberapa kawasan yang telah dikaji berdasarkan mikrozonasi nilai 

frekuensi predominan dan nilai faktor amplifikasi pada keadaan geologi tertentu 

merepresentasikan kemungkinan adanya keberadaan sesar. Namun representasi 

tersebut kurang bisa menjelaskan secara detail mengenai letak jalur sesar, panjang 

sesar maupun kedalaman, sehingga hanya sebatas mengetahui kemungkinan 

adanya jalur sesar.  

 

3. Penampang Seismik Kurva H/V 

Kurva H/V hasil analisis pada software Sessaray Geopsy dapat 

merepresentasikan keadaan geologi daerah penelitian. Selain nilai frekuensi 

predominan dan faktor amplifikasi yang dapat memberikan informasi keadaan 
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geologi bawah permukaan lokasi penelitian, kurva H/V juga dapat dianalisis 

menjadi penampang seismik. Penampang seismik diinterpretasikan berdasarkan 

hubungan antara tiga parameter, yaitu ketebalan sedimen, periode predominan (𝑇0) 

dan kecepatan gelombang geser (𝑉𝑠). Ketebalan sedimen di permukaan berkaitan 

langsung dengan nilai periode predominan, sehingga spektrum dalam domain 

periode dapat diubah ke dalam domain kedalaman untuk merepresentasikan 

ketebalan lapisan sedimen dan faktor amplifikasi di titik pengukuran. 

Sayatan pada peta geologi yang dibuat menjadi lintasan seperti pada 

Gambar 16 menggambarkan keadaan topografi pada area yang disayat, sedangkan 

spektrum penampang seismik kurva H/V menggambarkan ketebalan sedimen 

bawah permukaan. Penggabungan lintasan dengan spektrum kedalamannya 

membentuk penampang seismik kurva H/V. Penampang seismik kurva H/V untuk 

masing-masing lintasan penelitian ditunjukkan pada Gambar 27, 28, 29, dan 30. 

Gambar 27 menunjukkan penampang seismik pada lintasan 1, yaitu lintasan 

paling timur daerah penelitian. Lintasan 1 membentang dari utara ke selatan dan 

memotong dua sesar penelitian yaitu sesar tengah dan sesar selatan. Lintasan ini 

melalui keempat formasi pada daerah penelitian yaitu Aluvium, Formasi 

Kebobutak, Andesit, dan Dasit. Puncak kurva penampang seismik pada tiap titik 

menunjukkan batas antara sedimen dengan batuan. Sedimen pada lintasan ini 

bervariasi namun tidak signifikan, yaitu kurang dari 20 meter. Bagian selatan 

lintasan ini memiliki ketebalan sedimen yang lebih tipis dibandingkan pada bagian 

utara. Hal ini dikarenakan kawasan tersebut termasuk pada Formasi Andesit dan 

Dasit, yaitu formasi yang didominasi oleh batuan keras. Struktur kontrol pada 
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penampang seismik yang merepresentasikan keberadaan jalur sesar ditunjukkan 

oleh tidak jelasnya pola puncak kurva. Pola kurva H/V pada titik 39 dan 57 

menunjukkan kontrol struktur yang merepresentasikan kemungkinan adanya jalur 

sesar tengah dengan tidak jelasnya puncak kurva. Daerah yang dimungkinkan 

terdapat jalur sesar ditandai dengan lingkaran berwarna merah yang berada pada 

jalur sesar tengah. Sedangkan pada kawasan jalur sesar selatan, pola puncak kurva 

H/V tidak merepresentasikan adanya jalur sesar.  

 
Gambar 27. Penampang seismik kurva H/V lintasan 1 daerah penelitian 

 

Gambar 28 merupakan penampang seismik pada lintasan 2 daerah 

penelitian. Lintasan ini membentang dari utara ke selatan yang  memotong ketiga 

sesar pada daerah penelitian. Lintasan 2 melalui Formasi Kebobutak, Andesit dan 

Dasit. Ketebalan sedimen pada lintasan ini bervariasi, dengan ketebalan kurang dari 

25 meter. Bagian utara lintasan memiliki ketebalan sedimen yang lebih besar 

dibandingkan bagian selatannya. Hal ini dikarenakan kawasan ini berada pada 

Formasi Kebobutak yang tergolong pada formasi dengan sedimen sedang. 
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Sedangkan pada bagian selatan lintasan mempunyai ketebalan sedimen sangat tipis 

karena kawasan tersebut termasuk pada Formasi Andesit dan Dasit. Berdasarkan 

pola puncak kurva H/V penampang seismik, terdapat dua kawasan yang 

merepresentasikan kemungkinan adanya jalur sesar yaitu kawasan yang terletak 

pada titik 41 dan 59, serta kawasan di titik 5. Kedua kawasan ini berada pada jalur 

sesar berdasarkan peta geologi, yaitu sesar tengah dan sesar selatan. Pada jalur sesar 

utara, pola puncak kurva H/V tidak merepresentasikan adanya jalur sesar. 

 

Gambar 28. Penampang seismik kurva H/V lintasan 2 daerah penelitian 

 

Gambar 29 merupakan lintasan ketiga penampang seismik daerah penelitian 

yang membentang dari utara ke selatan dan memotong ketiga sesar daerah 

penelitian. Lintasan tersebut melalui Formasi Kebobutak, Andesit dan Dasit. 

Ketebalan sedimen pada lintasan tersebut bervariasi dan cukup signifikan, namun 

secara keseluruhan kedalaman sedimen  kurang dari 25 meter. Pada bagian selatan 

lintasan ketebalan sedimennya tergolong sedang, meskipun kawasan ini termasuk 
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pada Formasi Dasit dimana formasi tersebut didominasi batuan keras. Ketebalan 

sedimen yang tergolong sedang dapat terjadi akibat batuan yang mengalami 

perubahan fisik karena terjadinya pelapukan atau deformasi berupa patahan atau 

sesar. Perbedaan ketebalan sedimen yang signifikan pada daerah titik 43, 34 dan 16 

juga dapat dimungkinkan oleh adanya jalur sesar, namun pola puncak kurva H/V 

pada titik-titik tersebut tidak merepresentasikan adanya jalur sesar sehingga 

dimungkinkan jalur sesar tidak terletak pada jalur sesar yang tercantum di peta 

geologi. Sedangkan kawasan titik 97 dan 79 merepresentasikan kemungkinan 

adanya jalur sesar yang dicerminkan dari pola puncak kurva H/V yang 

menunjukkan kontrol struktur di  kawasan tersebut. Kawasan ini berada pada jalur 

sesar utara berdasarkan peta geologi.  

 
Gambar 29. Penampang seismik kurva H/V lintasan 3 daerah penelitian 

 

Gambar 30 merupakan lintasan keempat yaitu lintasan paling barat pada 

daerah penelitian. Lintasan ini membentang dari utara ke selatan dan memotong 
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satu garis sesar  yaitu sesar utara daerah penelitian. Lintasan 4 hanya melalui 

Formasi Dasit saja sehingga ketebalan sedimen pada lintasan ini hampir homogen 

dengan kedalaman kurang dari 20 meter. Berdasarkan pola puncak kurva H/V tidak 

ditemukan adanya titik yang merepresentasikan kemungkinan adanya jalur sesar. 

Titik 81 mempunyai ketebalan sedimen paling besar di antara yang lain, hal ini 

dimungkinkan karena adanya perubahan fisik batuan berupa pelapukan.  

 

Gambar 30. Penampang seismik kurva H/V lintasan 4 daerah penelitian 

 

 

B. Analisis Struktur Bawah Permukaan dan H/V Rotate di Kawasan Sesar 

1. Analisis Struktur Bawah Permukaan 

Ellipticity curve merupakan metode inversi untuk mengetahui struktur 

bawah permukaan (ground profiles) berdasarkan kurva H/V (Novianita, 2009). 

Penentuan parameter merupakan awal yang penting dilakukan sebagai inisialisasi 
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dalam metode ini. Parameter model yang dijadikan inputan yaitu 𝑉𝑠 (kecepatan 

gelombang S), 𝑉𝑝 (kecepatan gelombang P), Poisson ratio, dan massa jenis 

(densitas) batuan. Penentuan nilai parameter berbeda beda pada setiap titik karena 

didasarkan pada formasi geologi daerah penelitian. Berdasarkan informasi 

penyusun formasi batuan pada daerah penelitian, banyaknya lapisan pada 

pemodelan ini adalah 3 lapisan (layer) dan 4 lapisan (layer).  

Pada kurva ellipticity curve yang ditunjukkan pada Gambar 18(a) terlihat 

beberapa macam warna garis yang menunjukkan macam model kurva dengan nilai 

misfit yang berbeda. Semakin kecil nilai misfit maka model kurva semakin 

mendekati model kurva referensi sehingga mendekati kondisi sebenarnya. Kurva 

dengan garis hitam menunjukkan kurva H/V sebagai model referensi untuk metode 

ellipticity curve, dan kurva dengan garis putih menunjukkan kurva hasil dari metode 

ellipticity curve dengan nilai misfit terkecil. Kurva pada ellipticity curve merupakan 

kurva yang merepresentasikan data dari nilai frekuensi dan nilai eliptisitas 

gelombang Rayleigh yang dapat digunakan untuk pemodelan ground profiles 

berdasarkan nilai 𝑉𝑠 

Ground profiles merupakan hasil dari pengolahan data dengan metode 

ellipticity curve yang menggambarkan keadaan bawah permukaan berdasarkan nilai 

𝑉𝑠. Nilai 𝑉𝑠 pada setiap titik berbeda pada tiap lapisannya (layer), bergantung pada 

batuan yang tersusun pada titik tersebut. Banyaknya lapisan (layer) pada tiap titik 

penelitian juga berbeda, ditentukan dari informasi geologi daerah tersebut untuk 

kedalaman 100 meter.  
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(a)                                       (b) 

Gambar 31. Ground profiles 𝑉𝑠 dengan variasi lapisan (a) Ground profiles dengan 

3 lapisan pada titik 3 (b) Ground profiles dengan 4 lapisan pada titik 45 

daerah penelitian. 

 

Gambar 31 menunjukkan ground profiles 𝑉𝑠 dengan jumlah lapisan yang 

berbeda. Gambar 31(a) adalah ground profiles 𝑉𝑠 dengan 3 lapisan yang terletak  

pada titik 3 sedangkan 31(b) adalah ground profiles 𝑉𝑠 dengan 4 lapisan yang 

terletak pada titik 45. Sumbu mendatar pada ground profiles menunjukkan nilai 

kecepatan gelombang geser (𝑉𝑠) dengan satuan m/s dan sumbu vertikal 

menunjukkan kedalaman dengan satuan meter. Nilai 𝑉𝑠 di tiap lintasan pada ground 

profiles menunjukkan perbedaan jenis material di bawah permukaan. Nilai 𝑉𝑠 

berbanding lurus dengan kerapatan (densitas) batuan atau material. Semakin rapat 

kerapatan batuan maka semakin besar nilai 𝑉𝑠 dan begitu sebaliknya. Kerapatan 

batuan atau material berhubungan dengan jenis batuan sehingga metode ini 

memudahkan peneliti untuk mengetahui profil atau struktur di bawah permukaan. 

Nilai 𝑉𝑠 beserta kedalamannya untuk semua titik selanjutnya menjadi data input 

pada pengolahan Solid Model 3D. 
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Data hasil ground profiles beserta nilai 𝑉𝑠 di daerah penelitian secara 

lengkap terdapat pada Lampiran 3.  Nilai 𝑉𝑠 tertinggi terletak pada titik 34 dengan 

nilai sebesar 3215,25 m/s. Berdasarkan Tabel 6, nilai tersebut tergolong dalam 

batuan keras. Sedangkan nilai terendah pada daerah penelitian terletak pada titik 73 

dengan nilai sebesar 47,113 m/s, dan tergolong pada tanah lunak. Maka dapat 

disimpulkan bahwa penyusun material pada daerah penelitian berupa tanah lunak 

hingga batuan keras. 

Pemodelan 3D nilai 𝑉𝑠 hasil dari metode ellipticity curve menggambarkan 

struktur bawah permukaan secara menyeluruh pada daerah penelitian. Hal tersebut 

memudahkan untuk melihat struktur bawah permukaaan daerah penelitian sehingga 

dapat diketahui kemungkinan keberadaan jalur patahan atau sesar dari strukturnya. 

Pemodelan 3D yang mencakup 32 titik ditunjukkan pada Gambar 32. 

 

Gambar 32. Model 3D nilai 𝑉𝑠 daerah penelitian hasil metode ellipticity curve 
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Gambar 32 merupakan pemodelan struktur bawah permukaan secara 3D di 

daerah penelitian berdasarkan nilai 𝑉𝑠 dengan kedalaman 100 meter. Nilai 𝑉𝑠 

divisualisasikan dengan skala warna dari warna ungu sebagai nilai terendah hingga 

merah sebagai nilai tertinggi. Berdasarkan Tabel 6, daerah penelitian terdiri dari 

tanah lunak (𝑉𝑠 < 175 m/s) hingga batuan keras (𝑉𝑠 ≥ 1500 m/s). Garis berwarna 

hitam pada permukaan model, merupakan garis sesar berdasarkan peta geologi, 

dimana terdapat 3 jalur sesar minor yang tercakup dalam daerah penelitian. 

Berdasarkan Gambar 32, seluruh permukaan pada lokasi penelitian berupa 

sedimen, sehingga belum bisa diketahui keberadaan sesar jika ditinjau dari kondisi 

struktur tanah pada permukaan.  

 

Gambar 33. 12 sayatan solid model 3D nilai 𝑉𝑠 hasil metode ellipticity curve 

 

Penyayatan pada solid model dilakukan untuk mempermudah dalam 

mengidentifikasi struktur bawah permukaan dengan lebih detail. Gambar 33 

merupakan solid model nilai 𝑉𝑠 dengan 12 sayatan yang arahnya tegak lurus 
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terhadap sesar. Pada penampang sayatan terlihat adanya perbedaan kedalaman 

antara batuan satu dengan yang lainnya. Hal tersebut dapat divisualisasikan dari 

perbedaan ketinggian warnanya.  

Gambar 34(a) merupakan sayatan ke empat dari selatan yang memotong 

sesar selatan daerah penelitian. Warna hijau yang menunjukkan batuan keras pada 

sayatan mempunyai variasi kedalaman yang signifikan dimana pada area tengah 

penampang sayatan batuan kerasnya berada pada kedalaman 50 meter sedangkan 

sebelah barat dan timurnya berada pada kedalaman 100 meter. Hal tersebut diduga 

sebagai patahan atau sesar yang berupa sesar naik, sesar ini terjadi apabila hanging 

wall relatif bergerak naik terhadap foot wall. Hanging wall (warna hijau) yang 

bergerak naik mengakibatkan batuan berada pada kedalaman yang lebih dangkal 

dibanding  foot wall yaitu area sebelah barat dan timurnya. Umumnya sesar naik 

tidak pernah berdiri sendiri atau berkembang tunggal. Sesar naik selalu membentuk 

suatu zona, sehingga pada zona sesar dijumpai sejumlah bidang sesar (Sambodo, 

2012) Jalur sesar selatan merupakan patahan sebelah timur dari hanging wall.  

Gambar 34(b) merupakan sayatan bagian tengah daerah penelitian yaitu 

sayatan kedelapan dari selatan yang memotong sesar tengah. Hanging wall yang 

berada pada bagian timur penampang sayatan terdapat pada kedalaman 60 meter 

sedangkan foot wall yang berada pada bagian tengah berada pada kedalaman 90 

meter di bawah permukaan. Sesar tengah merupakan patahan sebelah barat dari 

hanging wall yang  sama dengan sesar selatan, sehingga sesar tersebut masih dalam 

satu zona dengan sesar selatan daerah penelitian.  
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      a) 

 

b) 

 

(c) 

Gambar 34. Penampang struktur bawah permukaan yang disayat secara vertikal, (a) 

Sayatan bagian selatan, (b) Sayatan bagian tengah, (c) Sayatan bagian 

utara 
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Gambar 34(c) merupakan sayatan yang memotong sesar utara. Pada sayatan 

tersebut terdapat perbedaan kedalaman batuan di bagian barat. Sedangkan daerah 

yang memotong garis sesar tidak teridentifikasi adanya perbedaan kedalaman 

batuan, sehingga pada sayatan ini diinterpretasikan bahwa letak dan panjang jalur 

sesar tidak sama seperti yang tercantum pada peta geologi .  

Berdasarkan identifikasi sesar dengan mengkaji struktur bawah permukaan 

dimungkinan bahwa keberadaan jalur sesar pada daerah penelitian berupa segmen-

segmen sehingga jalur sesar tidak sepanjang garis sesar yang tercantum pada peta 

geologi. Jalur sesar utara bergeser ke selatan dari garis sesar yang tercantum peta 

geologi.  

 

2. H/V Rotate pada Kawasan Sesar 

Amplifikasi merupakan pembesaran amplitudo gelombang seismik yang 

terjadi pada permukaan tanah akibat jenis tanah tertentu. Gelombang seismik 

mengalami peningkatan amplitudo saat merambat dari media yang keras ke media 

yang lebih lunak. Amplifikasi berhubungan dengan kerapatan suatu material atau 

media. Jika suatu batuan terdapat rekahan yang menyebabkan kerapatan batuannya 

rendah, maka modulus elastisitas yang berkurang secara lokal menyebabkan 

penguatan gelombang (amplifikasi) di zona sesar (Pischiutta et al., 2017). 

Kerapatan yang kontras antara batuan normal dengan patahan atau rekahannya 

menghasilkan gelombang yang terperangkap yang akan memperlama durasi 

gelombang merambat, sehingga arah dari amplifikasi dapat mengindikasikan 

adanya sesar. 
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Nilai azimut sumber amplifikasi pada pengukuran gelombang mikroseismik 

dapat diketahui dengan menganalisis polarisasi arah sumber gelombang melalui 

pengolahan menggunakan H/V Rotate. H/V Rotate merupakan salah satu metode 

pengolahan sinyal mikrotremor pada software Sesarray Geopsy yang menghitung 

ulang sinyal mikrotremor dengan memutar dua komponen horizontal dari 0o sampai 

180o, sehingga dapat diketahui sejauh mana gerakan horizontal diperkuat 

dibandingkan gerakan vertikal. Hasil dari pengolahan ini berupa kurva seperti pada 

Gambar 15(b), dimana arah horizontal adalah nilai frekuensi, arah vertikal adalah 

polarisasi dalam bentuk sudut, dan spektrum warna adalah nilai amplifikasi. Nilai 

amplifikasi tertinggi ditandai oleh warna ungu, dan data yang digunakan adalah 2 

angka nilai amplifikasi tertinggi beserta besar sudutnya. Data kurva H/V rotate 

pada setiap titik secara lengkap terdapat pada Lampiran 3. 

 

Gambar 35. Diagram rose titik 3 daerah penelitian dari hasil pengolahan H/V 

Rotate  

 

Gambar 35 merupakan pengolahan lanjutan menggunakan data hasil dari 

kurva H/V Rotate. Data yang dimasukkan berupa nilai amplifikasi beserta besar 
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arah azimutnya. Besar sudut 0o merepresentasikan arah utara, sudut 90o 

merepresentasikan arah timur, dan sudut 180o merepresentasikan arah selatan. 

Karena gelombang bergerak pada dua arah, maka sudut 0o dapat merepresentasikan 

kemungkinan adanya jalur sesar pada arah utara atau selatan, begitu seterusnya. 

Pada diagram rose terdapat beberapa spektrum warna yang merepresentasikan nilai 

amplifikasi, dimana warna merah mewakili nilai amplifikasi tertinggi pada titik 

penelitian tersebut.  

Gambar 36 merupakan visualisasi arah sumber gelombang yang dioverlay 

dengan garis sesar berdasarkan peta geologi. Arah sumber gelombang pada daerah 

sesar utara cenderung bersifat random. Arah amplifikasi menyebar dari arah UTL-

SBD, TL-BD, hingga T-B. Jika terdapat suatu rekahan sesar, arah sumber 

gelombang mengarah tegak lurus terhadap sesar, namun arah sumber gelombang 

pada titik-titik penelitian tidak semuanya mengarah tegak lurus terhadap garis sesar. 

Hanya beberapa titik yang mengarah tegak lurus terhadap sesar yaitu UTL-SBD, 

sedangkan arah lainnya tidak merepresentasikan adanya rekahan sesar pada garis 

tersebut. Seperti identifikasi berdasarkan penampang seismik kurva H/V dan 

struktur bawah permukaan, hal tersebut dimungkinkan karena adanya sesar yang 

geser ke selatan terhadap garis sesar yang tercantum di peta geologi dan sesar yang 

ada berupa segmen-segmen sesar.  

Pada sesar tengah di daerah penelitian, arah sumber gelombang di titik-titik 

penelitian sekitar garis sesar mengarah U-S, UTL-SBD, hingga T-B. Arah sumber 

gelombang garis sesar kedua pada bagian barat mengarah U-S yang 

mengindikasikan adanya sesar pada daerah tersebut, sedangkan di bagian selatan 
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garis sesar dominan mengarah ke TTL-BBD karena adanya perpaduan atau 

pengaruh dari sesar selatan. Ditinjau dari arah sumber gelombangnya 

dimungkinkan sesar tengah tidak sepanjang seperti yang tercantum pada peta 

geologi namun berupa segmen-segmen sesar.  

 
Gambar 36. Pola persebaran arah sumber gelombang di kawasan sesar 
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Pada sesar selatan di daerah penelitian, arah sumber gelombang pada titik-

titik penelitian di daerah garis sesar dominan mengarah pada U-S, UBL-ST, dan 

TTL-BBD. Arah amplifikasi U-S dan UBL-ST mengindikasikan adanya rekahan 

atau sesar pada daerah tersebut, sedangkan arah TTL-BBD merupakan paduan dari 

sesar tengah dan sesar selatan. 

Pengidentifikasian keberadaan ketiga jalur sesar berdasarkan arah sumber 

gelombang dapat memperkuat identifikasi sesar dengan metode lain pada daerah 

penelitian. Sesar yang ada pada daerah penelitian diduga merupakan sesar naik 

yang berbentuk segmen-segmen sesar. Hal ini karena tidak semua arah sumber 

gelombang pada kawasan sesar merepresentasikan adanya sesar. Daerah penelitian 

merupakan zona sesar dimana terdapat banyak sesar yang merupakan segmen-

segmen sesar.  
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BAB V 

KESIMPULAN DAN SARAN 

 

A. Kesimpulan 

Berdasarkan hasil penelitian dapat diambil kesimpulan sebagai berikut:  

1. Kecamatan Bagelen Kabupaten Purworejo memiliki nilai frekuensi 

predominan dan faktor amplifikasi yang persebarannya bervariasi. Nilai 

frekuensi predominan antara 0,77 – 17,43 Hz dengan kategori jenis tanah I - 

IV dan nilai faktor amplifikasi antara 1,01 – 15,50 dengan kategori rendah 

hingga sangat tinggi. Beberapa pola  persebaran nilai frekuensi predominan 

dan faktor amplifikasi merepresentasikan adanya jalur sesar namun belum 

secara detail. Pola penampang seismik kurva H/V pada daerah penelitian 

menunjukkan ketebalan sedimen yang bervariasi namun tidak signifikan. 

Kurva penampang seismik pada kawasan sesar menunjukkan kontrol struktur 

yang merepresentasikan kemungkinan keberadaan ketiga jalur sesar yaitu sesar 

utara, sesar tengah, dan sesar selatan.  

2. Berdasarkan nilai kecepatan gelombang geser, struktur bawah permukaan pada 

daerah penelitian terdiri dari tanah lunak hingga batuan keras dengan nilai 

terendah 47,11 m/s dan tertinggi 3215,25 m/s. Berdasarkan  analisis struktur 

bawah permukaan, teridentifikasi kemungkinan adanya jalur sesar yang berupa 

sesar naik yang tidak berdiri sendiri melainkan berupa zona sesar. Sesar-sesar 

tersebut tidak sepanjang seperti yang tercantum pada peta geologi lembar 
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Yogyakarta melainkan hanya berupa segmen-segmen sesar. Letak jalur sesar 

juga bergeser dari garis sesar yang tercantum pada peta geologi lembar 

Yogyakarta. 

3. Pola arah sumber gelombang berdasarkan model H/V rotate pada kawasan 

sesar daerah penelitian bervariasi dari UTL-SBD hingga T-B. Berdasarkan 

pola arah sumber gelombang yang tidak semua merepresentasikan adanya 

sesar maka dimungkinkan sesar pada daerah penelitian berupa segmen sesar.  

 

B. Saran 

Beberapa hal yang perlu dilakukan untuk penelitian selanjutnya antara lain: 

1. Perlu dilakukan penelitian menggunakan metode lain khususnya metode untuk 

pengkajian struktur bawah permukaan serta identifikasi sesar seperti metode 

gravity ataupun geomagnet untuk membandingkan dan menarik kesimpulan 

terkait struktur bawah permukaan serta identifikasi 3 jalur sesar tersebut. 

2. Melakukan penelitian yang lebih detail terkait keberadaan 3 jalur sesar 

berdasarkan arah sumber gelombang dengan cara merapatkan atau 

memperkecil jarak antar titik pengambilan data. 
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Lampiran 1  

Kurva H/V Hasil Pengolahan Sinyal Mikrotremor 

 

Titik Kurva HVSR Kriteria 

1 

 

𝑓0 = 7,0271 

𝐴0= 5,253 

Kriteria Reliable  

1. Terpenuhi 7,0271 > 0,5 

2. Terpenuhi 1405.41 > 200 

3. Terpenuhi 1,2991 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 3,0682 > 2,6265 

2. Tidak terpenuhi 3,6993 > 2,6265 

3. Terpenuhi 5,253 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,0918 < 1,7567 

6. Terpenuhi 1,2992 < 3 

3 

 

𝑓0 = 11,4817 

𝐴0= 10,6546 

Kriteria Reliable  

1. Terpenuhi 11,4817 > 0,5 

2. Terpenuhi 2296,34 > 200 

3. Terpenuhi 1,9595 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 5,3273 > 5,001 

2. Tidak terpenuhi 8,6867 > 5,001 

3. Terpenuhi 10,6546 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,2891 < 2,8704 

6. Terpenuhi 1,9595 < 3 

5 

 

𝑓0 = 4,3456 

𝐴0 = 2,9722 

Kriteria Reliable  

1. Terpenuhi 4,3456 > 0,5 

2. Terpenuhi 869,118 > 200 

3. Terpenuhi 0,2981 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 2,1304 > 1,4861 

2. Tidak terpenuhi 2,4168 > 1,4861 

3. Terpenuhi 2,9722 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,0879 < 1,0864 

6. Terpenuhi 0,2981 < 3 
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Titik Kurva HVSR Kriteria 

9 

 

𝑓0 = 6,038 

𝐴0= 6,5481 

Kriteria Reliable  

1. Terpenuhi 6,038 > 0,5 

2. Terpenuhi 1207,61 > 200 

3. Terpenuhi 1,0944 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 3,9639 > 3,2741 

2. Tidak terpenuhi 4,3488 > 3,2741 

3. Terpenuhi 6,5481 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,2851 < 1,5095 

6. Terpenuhi 1,0944 < 3 

16 

 

𝑓0 = 4,8841 

𝐴0= 5,8778 

Kriteria Reliable  

1. Terpenuhi 4,8841> 0,5 

2. Terpenuhi 976,83 > 200 

3. Terpenuhi 0,8246 < 2 

Kriteria Clear Peak 

1. Terpenuhi 2,9069 < 2,9389 

2. Tidak terpenuhi 4,3291 > 2,9389 

3. Terpenuhi 5,8778 > 2 

4. Terpenuhi 

5. Terpenuhi 0,5955 < 1,2211 

6. Terpenuhi 0,8246 < 3 

19 

 

𝑓0 = 2,5769 

𝐴0= 3,4833 

Kriteria Reliable  

1. Terpenuhi 2,5769> 0,5 

2. Terpenuhi 515,39 > 200 

3. Terpenuhi 0,4036 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 2,6858 > 1,7417 

2. Tidak terpenuhi 3,2479 > 1,7417 

3. Terpenuhi 3,4833 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,0333 < 0,6442 

6. Terpenuhi 0,4036 < 3 
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Titik Kurva HVSR Kriteria 

21 

 

𝑓0 = 10,7781 

𝐴0= 6,5481 

Kriteria Reliable  

1. Terpenuhi 10,7781> 0,5 

2. Terpenuhi 2155,62 > 200 

3. Tidak terpenuhi 3,3993 > 2 

Kriteria Clear Peak 

1. Terpenuhi 5,0258 < 7,7519 

2. Terpenuhi 7,4972 < 7,7519 

3. Terpenuhi 15,5038 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,6521 < 2,6945 

6. Tidak terpenuhi 3,3993 > 3 

23 

 

𝑓0 = 17,4365 

𝐴0= 6,8364 

Kriteria Reliable  

1. Terpenuhi 17,4365 > 0,5 

2. Terpenuhi 3487,3 > 200 

3. Terpenuhi 1,4975 < 2 

Kriteria Clear Peak 

1. Terpenuhi 3,1251 < 3,4182 

2. Tidak terpenuhi 6,6457 > 3,4182 

3. Terpenuhi 6,8364 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,0955 < 4,3591 

6. Terpenuhi 1,4975 < 3 

27 

 

𝑓0  = 7,2893 

𝐴0 = 7,9403 

Kriteria Reliable  

1. Terpenuhi 7,2893 > 0,5 

2. Terpenuhi 1457,86 > 200 

3. Tidak terpenuhi 2,2483 > 2 

Kriteria Clear Peak 

1. Terpenuhi 3,2687 < 3,9701 

2. Tidak terpenuhi 4,8114> 3,9701 

3. Terpenuhi 7,9403 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,0778 < 1,8223 

6. Terpenuhi 2,2483 < 3 
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Titik Kurva HVSR Kriteria 

34 

 

𝑓0  = 9,1597 

𝐴0 = 6,7096 

Kriteria Reliable  

1. Terpenuhi 9,1597 > 0,5 

2. Terpenuhi 1831,94 > 200 

3. Terpenuhi 1,0652 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 4,1395 > 3,3548 

2. Tidak terpenuhi 5,0549 > 3,3548 

3. Terpenuhi 6,7096 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,0869 < 2,2899 

6. Terpenuhi 1,0652< 3 

37 

 

𝑓0  = 5,2528 

𝐴0 = 6,202 

Kriteria Reliable  

1. Terpenuhi 5,2528 > 0,5 

2. Terpenuhi 1050,56 > 200 

3. Terpenuhi 1,2827 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 3,8902 > 3,101 

2. Tidak terpenuhi 3,8429 > 3,101 

3. Terpenuhi 6,202 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,4086 < 1,3132 

6. Terpenuhi 1,2827< 3 

39 

 

𝑓0  = 0,7778 

𝐴0 = 1,0167 

Kriteria Reliable  

1. Terpenuhi 0,7778 > 0,5 

2. Terpenuhi 1555,66 > 200 

3. Terpenuhi 0,13 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 1,0179 > 0,5083 

2. Tidak terpenuhi 0,6765 > 0,5083 

3. Tidak terpenuhi 1,0167 < 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,0281 < 0,1944 

6. Terpenuhi 0,13< 3 
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Titik Kurva HVSR Kriteria 

41 

 

𝑓0  = 9,2019 

𝐴0 = 2,962 

Kriteria Reliable  

1. Terpenuhi 9,2019 > 0,5 

2. Terpenuhi 1840,39 > 200 

3. Terpenuhi 0,6959 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 2,2734 > 1,481 

2. Tidak terpenuhi 3,5081 > 1,481 

3. Terpenuhi 2,962 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,0813 < 2,3 

6. Terpenuhi 0,6959 < 3 

43 

 

𝑓0 = 5,1389 

𝐴0 = 6,2204 

Kriteria Reliable  

1. Terpenuhi 5,1389 > 0,5 

2. Terpenuhi 1027,78 > 200 

3. Terpenuhi 1,0279 < 2 

Kriteria Clear Peak 

1. Terpenuhi 3,0876 < 3,11 

2. Tidak terpenuhi 4,6892 > 3,11 

3. Terpenuhi 6,2204 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,3608 < 1,2847 

6. Terpenuhi 1,0279 < 3 

45 

 

𝑓0  = 11,5051 

𝐴0 = 4,3104 

Kriteria Reliable  

1. Terpenuhi 11,5051 > 0,5 

2. Terpenuhi 2301.02 > 200 

3. Terpenuhi 0,4912 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 3,2557 > 2,1552 

2. Tidak terpenuhi 4,6993 > 2,1552 

3. Terpenuhi 4,3104 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,1089 < 2,8762 

6. Terpenuhi 0,4912 < 3 
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Titik Kurva HVSR Kriteria 

54 

 

𝑓0  = 16,1387 

𝐴0 = 10,4569 

Kriteria Reliable  

1. Terpenuhi 16,1496 > 0,5 

2. Terpenuhi 3550,51> 200 

3. Tidak terpenuhi 2,3652 > 2 

Kriteria Clear Peak 

1. Terpenuhi 4,8928 < 5,2284 

2. Tidak terpenuhi 9,76557 > 5,2284 

3. Terpenuhi 10,4569 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,6088 < 4,0346 

6. Terpenuhi 2,3652 < 3 

55 

 

𝑓0  = 5,9829 

𝐴0 = 9,2246 

Kriteria Reliable  

1. Terpenuhi 5,9829 > 0,5 

2. Terpenuhi 1196,58 > 200 

3. Terpenuhi 1,7876 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 6,6753 > 4,6123 

2. Tidak terpenuhi 5,5543 > 4,6123 

3. Terpenuhi 9,22463> 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,2678 < 1,4957 

6. Terpenuhi 1,7876 < 3 

57 

 

𝑓0  = 4,6368 

𝐴0 = 9,22463 

Kriteria Reliable  

1. Terpenuhi 4,6368 > 0,5 

2. Terpenuhi 1112,84 > 200 

3. Terpenuhi 0,316023< 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 2,0998 > 1,45392 

2. Tidak terpenuhi 2,6172 > 1,45392 

3. Terpenuhi 2,9078 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,1602 < 1,1592 

6. Terpenuhi 0,3161 < 3 
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Titik Kurva HVSR Kriteria 

59 

 

𝑓0  = 9,0746 

𝐴0 = 2,507 

Kriteria Reliable  

1. Terpenuhi 9,0746 > 0,5 

2. Terpenuhi 2177,91 > 200 

3. Terpenuhi 0,3111 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 1,882 > 1,2535 

2. Tidak terpenuhi 2,516 > 1,2535 

3. Terpenuhi 2,507 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,3111 < 2,2686 

6. Terpenuhi 2,3652 < 3 

63 

 

𝑓0  = 14,02 

𝐴0 = 10,4971 

Kriteria Reliable  

1. Terpenuhi 14,02 > 0,5 

2. Terpenuhi 2804 > 200 

3. Terpenuhi 2,5508 < 2 

Kriteria Clear Peak 

1. Terpenuhi 3,5597 < 5,2485 

2. Tidak terpenuhi 6,8915 > 5,2485 

3. Terpenuhi 10,4971 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,6756 < 3,505 

6. Terpenuhi 2,5508 < 3 

73 

 

𝑓0  = 4,9255 

𝐴0 = 6,943 

Kriteria Reliable  

1. Terpenuhi 4,9255 > 0,5 

2. Terpenuhi 1182,142 > 200 

3. Terpenuhi 1,1637 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 4,0597 > 3,4713 

2. Tidak terpenuhi 4,0241 > 3,4713 

3. Terpenuhi 6,9427 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,2179 < 1,2313 

6. Terpenuhi 1,1637 < 3 
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Titik Kurva HVSR Kriteria 

75 

 

𝑓0  = 7,3495 

𝐴0  = 6,7022 

Kriteria Reliable  

1. Terpenuhi 7,3495 > 0,5 

2. Terpenuhi 1616,89 > 200 

3. Terpenuhi 1,31831 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 3,467 > 3,3511 

2. Tidak terpenuhi 4,025 > 3,3511 

3. Terpenuhi 6,7022 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,3291 < 1,8373 

6. Terpenuhi 1,3183 < 3 

77 

 

𝑓0  = 5,9567 

𝐴0 = 9,5005 

Kriteria Reliable  

1. Terpenuhi 5,9567 > 0,5 

2. Terpenuhi 1310,48 > 200 

3. Tidak terpenuhi 2,1831 > 2 

Kriteria Clear Peak 

1. Terpenuhi 4,1918 < 4,7502 

2. Tidak terpenuhi 4,9785 > 4,7502 

3. Terpenuhi 9,5005 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,2587 < 1,4892 

6. Terpenuhi 2,1830 < 3 

79 

 

𝑓0  = 13,9617 

𝐴0 = 3,6308 

Kriteria Reliable  

1. Terpenuhi 13,9617 > 0,5 

2. Terpenuhi 2792,34 > 200 

3. Terpenuhi 0,5475 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 2,6422 > 1,8154 

2. Tidak terpenuhi 3,6609 > 1,8154 

3. Terpenuhi 3,6308 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,4812 < 3,4904 

6. Terpenuhi 0,5477 < 3 
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Titik Kurva HVSR Kriteria 

81 

 

𝑓0   = 8,766 

𝐴0  = 5,5333 

Kriteria Reliable  

1. Terpenuhi 8,76602 > 0,5 

2. Terpenuhi 1753,2 > 200 

3. Terpenuhi 1,2794 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 3,0276 > 2,766 

2. Tidak terpenuhi 5,5493 > 2,766 

3. Terpenuhi 5,5333 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,3908 < 2,1915  

6. Terpenuhi 1,2794 < 3 

91 

 

𝑓0   = 9,9494  

𝐴0  = 8,2609 

Kriteria Reliable  

1. Terpenuhi 9,9494 > 0,5 

2. Terpenuhi 2586,86 > 200 

3. Terpenuhi 1,8521 < 2 

Kriteria Clear Peak 

1. Terpenuhi 3,8092 < 4,1304 

2. Tidak terpenuhi 6,1866 > 4,1304 

3. Terpenuhi 8,2609 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,4484 < 2,4873 

6. Terpenuhi 1,8521 < 3 

93 

 

𝑓0   = 14,1544 

𝐴0    = 7,9659 

Kriteria Reliable  

1. Terpenuhi 14,1544 > 0,5 

2. Terpenuhi 3397,05 > 200 

3. Terpenuhi 1,9747 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 4,6850 > 3,9829 

2. Tidak terpenuhi 6,0581 > 3,9829 

3. Terpenuhi 7,9659 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,5331 < 3,5386 

6. Terpenuhi 1,9747 < 3 
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Titik Kurva HVSR Kriteria 

95 

 

𝑓0   = 11,1289 

𝐴0  = 7,3794 

Kriteria Reliable  

1. Terpenuhi 11,1289 > 0,5 

2. Terpenuhi 2893,51 > 200 

3. Terpenuhi 1,555 < 2 

Kriteria Clear Peak 

1. Terpenuhi 3,0331 < 3,6897 

2. Tidak terpenuhi 4,9846 > 3,6897 

3. Terpenuhi 7,3794 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,4971 < 2,7822 

6. Terpenuhi 1,555 < 3 

S97 

 

𝑓0   = 4,6699 

𝐴0  = 2,7636 

Kriteria Reliable  

1. Terpenuhi 4,6699 > 0,5 

2. Terpenuhi 933,99 > 200 

3. Terpenuhi 0,2875 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 1,8774 > 1,3818 

2. Tidak terpenuhi 2,3129 > 1,3818 

3. Terpenuhi 2,7636 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,2105 < 1,1674  

6. Terpenuhi 0,2875 < 3 

99 

 

𝑓0  = 8,6199 

𝐴0   = 7,4245 

Kriteria Reliable  

1. Terpenuhi 8,6199 > 0,5 

2. Terpenuhi 1723,98 > 200 

3. Terpenuhi 1,6286 < 2 

Kriteria Clear Peak 

1. Terpenuhi 3,4225 < 3,7122  

2. Tidak terpenuhi 4,9295 > 3,7122 

3. Terpenuhi 7,4245 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,3776 < 2,1549  

6. Terpenuhi 1,6286 < 3 
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Titik Kurva HVSR Kriteria 

T1 

 

𝑓0  = 7,1445 

𝐴0  = 3,3999 

Kriteria Reliable  

1. Terpenuhi 7,1445 > 0,5 

2. Terpenuhi 1428,91 > 200 

3. Terpenuhi 0,3175 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 2,6028 > 1,6999 

2. Tidak terpenuhi 3,0121 > 1,6999 

3. Terpenuhi 3,3999 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,3181 < 1,7861  

6. Terpenuhi 0,3175 < 3 

T2 

 

𝑓0   = 7,9273 

𝐴0  = 7,7972 

Kriteria Reliable  

1. Terpenuhi 7,9273 > 0,5 

2. Terpenuhi 1585,47 > 200 

3. Terpenuhi 1,8232 < 2 

Kriteria Clear Peak 

1. Tidak terpenuhi 5,2281 > 3,8986 

2. Tidak terpenuhi 6,1657 > 3,8986 

3. Terpenuhi 7,7972 > 2 

4. Tidak terpenuhi 

5. Terpenuhi 0,1673 < 1,9818 

6. Terpenuhi 1,8232 < 3 
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Lampiran 2 

Hasil Kriteria Kurva Reliable dan Kurva Clear Peak berdasarkan  

SESAME European Research Project 

Titik 𝑛𝑤 𝑓0 𝐴 
Reliable Clear Peak 

1 2 3 1 2 3 4 5 6 

1 10 7,027 5,253 V V V - - V - V V 

3 10 11,4817 10,6546 V V V - - V - V V 

5 10 4,34559 2,97229 V V V - - V - V V 

9 10 6,03801 6,54816 V V V - - V - V V 

16 10 4,88417 5,87789 V V V V - V V V V 

19 10 2,57699 3,48334 V V V - - V - V V 

21 10 10,7781 15,5038 V V - V V V - V - 

23 10 17,4365 6,8364 V V V V - V - V V 

27 10 7,28934 7,9403 V V - V V V - V - 

34 10 9,15974 6,70965 V V V - - V - V V 

37 10 5,25281 6,20205 V V V - - V - V V 

39 10 0,7778 1,01674 V V V - - - - V V 

41 10 9,201995 2,96202 V V V - - V - V V 

43 10 5,13893 6,22047 V V V V - V - V V 

45 10 11,5051 4,3104 V V V - - V - V V 

54 10 16,1496 11,7135 V V - V - V - V V 

55 10 5,98294 9,22463 V V V - - V - V V 

57 12 4,63683 2,90784 V V V - - V - V V 

59 12 9,07465 2,50703 V V V - - V - V V 

63 10 14,2503 13,5457 V V - V - V - V V 

73 12 4,92559 6,94271 V V V - - V - V V 

75 11 7,34952 6,70227 V V V - - V - V V 

77 10 5,97722 11,2007 V V - V V V - V V 

79 10 13,9617 3,63087 V V V - - V - V V 

81 10 8,76602 5,53333 V V V - - V - V V 

91 13 9,94949 8,26095 V V V V - V - V V 

93 10 9,20195 9,5519 V V - V - V - V V 

95 13 11,1289 7,37946 V V V V - V - V V 

97 10 4,66999 2,76369 V V V - - V - V V 

99 10 8,61994 7,42457 V V V V - V - V V 

T2 10 7,14454 3,39998 V V V - - V - V V 

T1 10 7,9273 7,7972 V V V - - V - V V 

 

Tanda (V) menunjukkan bahwa syarat terpenuhi dan tanda (-) menunjukkan 

bahwa syarat tidak terpenuhi,



 

90 

 

Keterangan Syarat: 

Kriteria untuk Kurva HVSR yang Reliable 

1. 𝑓0 > 10
𝑙𝑤

⁄  

2. 𝑛𝑐(𝑓0) > 200 dimana 𝑛𝑐 = 𝑛𝑤 𝑙𝑤𝑓0 

3. 𝜎𝐴(𝑓) < 2 untuk 0,5𝑓0 < 𝑓 < 2𝑓0 jika 𝑓0 > 0,5 Hz atau 

𝜎𝐴(𝑓) < 3 untuk 0,5𝑓0 < 𝑓 < 2𝑓0 jika 𝑓0 < 0,5 Hz 

 

Kriteria untuk Kurva HVSR yang Clear Peak 

1. ∃𝑓− ∈ [𝑓0 4⁄ , 𝑓0] |𝐴𝐻𝑉(𝑓−) < 𝐴0 2⁄  

2. ∃𝑓+ ∈ [𝑓0, 4𝑓0] |𝐴𝐻𝑉(𝑓+) < 𝐴0 2⁄  

3. 𝐴0 > 2 

4. 𝑓𝑝𝑒𝑎𝑘[𝐴𝐻/𝑉(𝑓) ± 𝜎𝐴(𝑓)] = 𝑓0 ± 5% 

5. 𝜎𝑓 < 𝜀(𝑓0) 

6. 𝜎𝐴(𝑓0) < 𝜃(𝑓0) 
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Lampiran 3 

Hasil Analisis nilai 𝑽𝒔 dengan metode inversi, arah sumber gelombang dengan H/V Rotate, dan Spektrum penampang kurva H/V  

 

Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit Ground Profiles 𝒗𝒔 (m/s) 
Kedalaman 

(m) 
H/V Rotate Diagram Rose 

S9 0,289 

 

119,35 2,61 

   

441,96 18,09 

1454,62 72,18 

2744,06 100 

S23 0,212 

 

488,03 8,92 

  
 

 

1349,68 55,7 

3109,39 100 
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Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman

(m) 
H/V Rotate Diaagram Rose 

S27 0,256 

 

101,97 3,14 

   

556,99 57,4 

1217,72 100 

  

S34 0,247 

 

174,93 3,98 

   

1370,05 59,7 

3215,25 100 

  

S43 0,258 

 

169,50 2,70 

   

469,82 13,97 

915,59 53,02 

1784,63 100 
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Titik 

Metode Inversi Arah Sumber Gelombang Spektrum Lintasan 

Penampang Seismik 
Misfit 

Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman

(m) 
H/V Rotate Diagram Rose 

S45 0,224 

 

124,46 1,74 

   

610,8 17,74 

1372,76 84,63 

2413,43 100 

S54 0,201 

 

215,462 3,573 

 
 

 

585,623 18,462 

1122,93 66,657 

2143,66 100 

S63 0,129 

 

176,189 2,306 

 

 

  

507,552 16,649 

1040,79 78,942 

2092,01 100 
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Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman 

(m) 
H/V Rotate Diagram Rose 

S81 0,159 

 

252,621 3,719 

   

640,486 17,005 

1245,94 62,172 

2201,41 100 

S99 0,152 

 

258,188 5,268 

 
  

681,606 25,384 

1333,56 80,528 

2008,01 100 

T2 0,209 

 

157,58 4,23 

   

510,23 18,09 

1007,02 92,56 

2216,82 100 
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Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman 

(m) 
H/V Rotate Diagram Rose 

S57 0,157 

 

153,45 2,280 

   

450,80 18,829 

1005,91 78,94 

1945,46 100 

S59 0,167 

 

120,19 1,798 

   

656,85 16,713 

1120,69 89,843 

2420,68 100 

S75 0,191 

 

194,483 3,235 

  
 

471,135 13,973 

800,343 40,935 

1535,70 100 
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Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman 

(m) 
H/V Rotate Diagram Rose 

S77 0,217 

 

151,352 3,831 

 
 

 

583,201 20,393 

1337,93 96,324 

2604,37 100 

S79 0,116 

 

220,836 1,375 

 
 

 

588,469 14,253 

1128,78 75,111 

2775,91 100 

S39 0,093 

 

66,74 3,017 

   

122 20,80 

200,3 39,73 

231,303 100 
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Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman 

(m) 
H/V Rotate Diagram Rose 

S93 0,322 

 

154,308 2,400 

   

525,489 20,471 

1005,16 81,608 

2313,27 100 

S95 0,164 

 

164,612 1,596 

   

541,081 14,026 

1266,02 69,201 

2277,91 100 

S97 0,13 

 

301,656 1,871 

   

554,298 13,126 

1263,72 65,354 

2477,41 100 
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Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman 

(m) 
H/V Rotate Diagram Rose 

T1 0,178 

 

130,196  

 
 

 
 

452,778 15,130 

932,041 87,201 

2046 100 

S21 0,24 

 

90,62 1,06 

   

400,41 7,61 

1437,25 43,02 

2996,32 100 

S41 0,156 

 

300,55 4,58 

   

627,61 15,90 

1113,97 72,17 

2293,51 100 
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Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman 

(m) 
H/V Rotate Diagram Rose 

S1 0,176 

 

147,84 3,502 

  
 

369,51 14,98 

846,19 75,10 

1693,41 100 

S19 0,296 

 

125,21 2,78 

   

366,56 37,42 

907,35 100 

  

S37 0,266 

 

286,473 5,42 

 
  

 

760,82 48,46 

2485,67 100 
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Titik 

Metode inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman 

(m) 
H/V Rotate Diagram Rose 

S55 0,378 

 

53,57 1,549 

   

254,858 13,427 

560,762 66,657 

1407,16 100 

 

S73 

 

0,334 

 

47,113 1,2447 

   

193,608 7,768 

690,520 59,154 

1454,72 100 

 

S91 

 

0,329 

 

88,035 2,173 

   

357,424 98,235 

1125,18 100 
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Titik 

Metode Inversi Arah Sumber Gelombang 
Spektrum Lintasan 

Penampang Seismik Misfit 
Ground 

Profiles 
𝒗𝒔 (m/s) 

Kedalaman 

(m) 
H/V Rotate Diagram Rose 

S3 0,209 

 

142,30 2,98 

   

1150,12 47,98 

2573,96 100 

  

S5 0,18 

 

472,668 11,11 

   

1186,30 68,65 

2605,08 100 

  

S16 0,228 

 

219,36 19,09 

   

565,07 13,56 

1262,14 77,38 

2816,27 100 
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Lampiran 4 

Langkah-Langkah Pengolahan Sinyal Mikrotremor 

A. Pengolahan Sinyal Mikrotremor dengan  Software Geopsy 

1.  Buka software Geopsy → klik OK pada jendela preferences. 

2. Masukkan sinyal mikrotremor dengan cara klik Import Signal kemudian 

memilih data yang sudah tersimpan dalam format .MSD. 

 
Gambar L1. Tampilan proses Import Signal 

 

3. Data yang telah diimport akan muncul seperti pada Gambar L2. 

 
Gambar L2. Tampilan sinyal yang telah diimport pada software Geopsy 
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4. Klik H/V pada toolbar,  untuk Length Window dipilih 20 sekon, → Start → Add 

untuk memulai windowing. 

 
Gambar L3. Tampilan pengaturan dalam H/V Toolbox 

5. Melakukan windowing sebanyak 10 window →  kembali ke menu H/V toolbox 

→ Output → Frequency Sampling (dari 0,5 Hz hingga 15 Hz atau 20 Hz). 

Sedangkan pada bagian Processing → Konno Omachi, Smoothing → 40,00, dan 

Horizontal Components → Square Average. 

 
Gambar L4. Tampilan H/V Toolbox pada bagian Output 
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Gambar L5. Tampilan H/V Toolbox pada bagian Processing 

 

b. Pilih Start hingga muncul hasil pengolahan sinyal mikrotremor menjadi kurva 

H/V seperti pada Gambar L6. 

 
Gambar L6. Tampilan Kurva H/V 

 

c. Kurva H/V disimpan dengan cara memilih menu Tools → Save Result, atau bisa 

dengan klik kanan pada kurva H/V → Properties → Save Layer. File disimpan 

dalam format .hv. 

d. Kurva H/V juga disimpan dalam bentuk gambar dengan cara memilih menu 

File → Export, dan file disimpan dalam format .jpg. 
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B. Cutting Sinyal Mikrotremor dengan Software Geopsy dan Command 

Prompt 

 

1. Buka sinyal mikrotremor yang akan dicutting. 

2. Pilih menu Waveform → Cut atau menekan tombol Ctrl+Alt+C. Pada jendela 

Cut Signals, pada Time Level → from this time dan to this time agar bisa diisi 

batasan waktu sinyal yang ingin dicutting seperti pada Gambar L7.  Pengisian 

waktu tersebut disesuaikan dengan waktu pada sebuah window yang dipilih saat 

melakukan pengolahan kurva H/V → klik OK. 

 
Gambar L7. Tampilan jendela Cut Signals 

 

3. Simpan hasil cutting tersebut dengan memilih menu File → Export → pilih 

format penyimpanan file → Ascii multi coloumns (no header) → OK. 
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Gambar L8. Tampilan jendela pemilihan tipe penyimpanan file 

 

4. Pilih lokasi dan nama file yang akan disimpan → Save. 

 
Gambar L9. Tampilan file hasil cutting 

5. Lakukan langkah 4 sampai 5 pada semua window yang dipilih dalam 

pengolahan sinyal mikrotremor.  

 

6. Setelah proses cutting selesai, dilakukan proses penggabungan file dengan 

Command Prompt. Buka Command Prompt → ubah direktori ke lokasi file-file 

hasil cutting tersimpan. 
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Gambar L10. Tampilan perubahan direktori pada Command Prompt 

 

7. Tulis program penggabungan file → copy/b (spasi) nama file pertama+nama file 

kedua+nama file ketiga+…+nama file terakhir (spasi) nama file yang akan 

disimpan. Hasil gabungan dalam format .xls. 

 
Gambar L11. Tampilan penulisan program penggabungan file 

 

8. Setelah selesai, klik Enter maka file gabungan akan masuk ke direktori yang 

sama dengan lokasi file-file hasil cutting. 
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Gambar L12. Tampilan hasil penggabungan file 

 

9. Untuk melihat hasil penggabungan sinyal yang telah dicutting, masukkan sinyal 

yang telah digabung tersebut di software Geopsy → muncul jendela Loading 

ASCII Columns → klik OK. 

 
Gambar L13. Tampilan jendela Loading ASCII Columns 

 

10. Sinyal yang muncul akan kosong, maka pengaturan pada tabel perlu diubah. 

Pilih menu Edit → hilangkan centang pada Lock Table Adition. 
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11. Pada bagian komponen sinyal diisi sesuai dengan urutan sinyal mikrotremor 

pengukuran, yaitu Vertical, East, dan North. Selain itu digunakan Sampling 

Frequency sebesar 100. 

 
Gambar L14. Tampilan pengisian tabel sinyal yang telah dimasukkan 

 

 

12. File yang telah dicutting kemudian dibuka di Microsoft Excel untuk dilakukan 

pengecekan sinyal mikrotemor. Sinyal mikrotremor terdiri dari tiga komponen, 

yaitu vertikal (V), barat-timur (E), dan utara-selatan (N). Setiap komponen 

dicari nilai maksimumnya, kemudian setiap nilai maksimum dikalikan dengan 

nilai 0,003. Apabila data mikrotremor baik, maka nilai akan <10, apabila ada 

yang >10 maka dilakukan windowing dan cutting ulang.  

 
Gambar L15. Tampilan Pengecekan Sinyal Mikrotremor 
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C. Pengolahan Kurva H/V untuk menentukan nilai 𝑽𝒔 dengan Program 

Dinver 

 

1. Buka program Dinver → muncul Dinver Plugin Selector → Surface Wave 

Inversion → klik OK. 

2. Pilih metode Ellipticity Curve → muncul Ellipticity Target → Load → Open 

(untuk membuka data kurva H/V) → klik OK. 

 
Gambar L17. Tampilan memasukkan data kurva H/V untuk diolah 

 

3. Mengisi parameter-parameter yaitu Compression-wave velocity (𝑉𝑝), Shear-

wave velocity (𝑉𝑠), Poisson ratio, dan Dencity. Pengisian parameter disesuaikan 

dengan kondisi geologi di lokasi penelitian. 
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Gambar L18. Tampilan pengisisan parameter 

 

4. Pilih menu Runs → Add untuk memulai inversi. 

5. Buka jendela Status untuk melihat proses running → menu Runs → Start. 

 
Gambar L19. Tampilan jendela Status 

 

6. Tunggu sampai proses running selesai, sehingga diperoleh grafik perolehan nilai 

misfit akhir. 
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Gambar L20. Tampilan proses running 

 

7. Pilih menu View → Ground profiles → muncul Ground profile viewer 

(ditampilkan 2 profil yaitu 𝑉𝑝 dan 𝑉𝑠) → Pilih misfit maksimal sebesar 1.  

Kemudian didapat informasi jumlah lapisan bawah permukaan beserta nilai 𝑉𝑠. 

 
Gambar L21. Tampilan ground profiles 
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D. Proses Pemodelan 3D Struktur Bawah Permukaan Berdasarkan Nilai 𝑽𝒔 

1. Membuka software Rockwork 16 → Utilities → input data pada kolom berupa 

data koordinat easting, koordinat northing, nilai kedalaman lapisan dan nilai 

kecepatan gelombang geser (𝑉𝑠) seperti pada Gambar L22. 

 
Gambar L22. Tampilan awal pengisian datasheet pada pemodelan 3D 

 

2. Klik scan datasheet → mengatur input column X, Y, dan Z sesuai data yang 

diinput seperti pada Gambar L23.  

 

Gambar L23. Tampilan pengaturan pada scan datasheet 
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3. Untuk membuat pemodelan 3D, klik menu Solid → Model → atur Input 

Column X, Y, Z, dan G sesuai data yang diinput. 

 
Gambar L24. Tampilan pada menu solid model 

 
 

4. Klik Option pada Filtering Option → atur Modeling Methods dan Additional 

Options sesuai kebutuhan → Process. 

Gambar 25. Tampilan menu pengaturan pemilihan model 
 

5. Simpan solid model 3D dengan format RLC. 
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Gambar L26. Tampilan solid model 3D yang telah diproses 

 

6. Memasukkan titik koordinat jalur sesar dengan cara klik Append to Current 

Scene → Recent →  pilih file koordinat jalur sesar hingga muncul garis sesar 

seperti pada Gambar L27. 

Gambar L27. Tampilan solid model 3D beserta jalur sesar 
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E. Pemodelan Sayatan Struktur Bawah Permukaan Berdasarkan Nilai 𝑽𝒔 

1. Melakukan langkah 1 dan 2 seperti pada proses pemodelan 3D struktur bawah 

permukaan berdasarkan nilai 𝑉𝑠. 

2. Pilih menu Solid → Fence →Section ➔ Fence Selection Map → buat sayatan 

dengan mengeklik ujung-ujung sayatan pada kotak yang tersedia sesuai dengan 

kebutuhan. 

 
Gambar L27. Tampilan Solid Model Fence 

 

7. Klik Process dan diperoleh hasil sayatan seperti yang ditunjukkan pada Gambar 

L28. 

 
Gambar L28. Tampilan hasil sayatan yang telah diproses 
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8. Masukkan titik koordinat jalur sesar dengan cara klik Append to Current Scene 

→ Recent → pilih file koordinat jalur sesar yang telah disimpan, maka akan 

muncul hasil sayatan beserta jalur sesarnya seperti pada Gambar L29. 

 

 
Gambar L29. Tampilan hasil sayatan beserta jalur sesar 
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F. Proses Mikrozonasi Menggunakan Software Surfer 11 

 

1. Membuka software Surfer 11 seperti yang ditunjukkan pada Gambar L30. 

 
L30. Tampilan software Surfer 11 

 

2. Klik ikon New Worksheet → input tabel dengan ketentuan kolom A adalah 

koordinat longitude, kolom B adalah koordinat latitude, dan kolom C adalah 

nilai parameter yang akan dimikrozonasi.  

 
L31. Tampilan pengisian Worksheet 

 

3. Worksheet disimpan dalam format .bln. 
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4. Untuk memulai proses mikrozonasi, kembali ke jendela Plot → menu Grid → 

Data → pilih file dalam format .bln yang akan dimikrozonasi → klik Open. 

 
Gambar L32. Tampilan proses mikrozonasi dengan Gridding 

 

5. Saat muncul tampilan pengaturan Gridding → pilih metode Natural Neighbor 

→ klik OK.  

 
Gambar L33. Tampilan pengaturan Gridding 

 

6. Hasil Gridding akan tersimpan dalam format .grd .  
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Gambar L34. Tampilan membuka hasil Gridding 

 

7. Menampilkan hasil Gridding dengan cara pilih ikon New Contour Map → pilih 

file yang telah disimpan dengan format .bln → klik Open, maka akan muncul 

hasil Gridding dalam bentuk kontur seperti yang ditunjukkan pada Gambar L35. 

 
Gambar L35. Tampilan hasil Gridding dalam bentuk kontur 

 

8. Atur warna dan tampilan kontur pada pilihan Level → Property Manager. 
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Gambar L36. Tampilan setelah diatur tampilannya 

 

9. Untuk memunculkan titik pengukuran dipilih ikon New Post Map → buka 

Worksheet yang sudah disimpan dalam bentuk .bln  dengan ketentuan kolom A 

adalah koordinat longitude, kolom B adalah koordinat latitude, dan kolom C 

adalah nama titik pengukuran. 

 
Gambar L37. Tampilan pengisian worksheet koordinat 

 

10. Satukan titik koordinat dengan dengan peta koordinat kontur dengan cara pilih 

menu Map → Overlay. Pengaturan simbol dan pemunculan nama titik koordinat 

dilakukan dengan cara Property Manager → General → Label. 
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L38. Tampilan hasil mikrozonasi 

 

11. Crop mikrozonasi menjadi 3 bagian berdasarkan kawasan jalur sesar dengan 

cara Property Manager → Limits→ isi koordinat pada Xmax,Ymax, Xmin, 

Ymin sesuai batas yang diinginkan → Enter. 

12. Simpan hasil crop mikrozonasi dengan pilih menu File → Export → simpan 

dalam bentuk .jpg. 

 

Gambar L39. Tampilan hasil Crop mikrozonasi 
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G. Pengolahan Penampang Seismik Kurva H/V 

 

1. Membuka Excel → isi tabel dengan data-data yang dibutuhkan, yaitu 𝐴0, 𝑓0, 𝑇0, 

𝑉𝑠, dan 𝐻. Nilai 𝐴0 dan 𝑓0 diperoleh dari data analisis HVSR yang disimpan 

dalam bentuk .hv, nilai 𝑇0 diperoleh dari perhitungan 
1

𝑓0
, nilai𝑉𝑠 diperoleh dari 

hasil analisis metode inversi, dan 𝐻 diperoleh dari hasil perhitungan 𝐻 =
𝑇0.𝑉𝑠

4
.  

 
Gambar L40. Tabel data input penampang kurva H/V 

 

2. Membuat grafik atau kurva kedalaman terhadap nilai faktor amplifikasi 

 
Gambar L41. Kurva kedalaman H/V 
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3. Membuat sayatan penampang menggunakan software Surfer 11 dengan cara 

buka Surfer 11 → New Base Map → pilih peta geologi dengan format .tiff → 

Open 

 
Gambar L42. Tampilan peta geologi pada software Surfer 11 

 

4. Tambahkan titik koordinat pada peta geologi dengan cara New Post Map → 

pilih file data titik koordinat dengan format .bln → Open → Overlay Map. 

 
Gambar L43. Tampilan peta geologi beserta titik penelitian 

 

5. Tambahkan data topografi daerah penelitian dengan cara New Contour Map → 

pilih file data topografi format .grid → Overlay Map.  
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6. Melakukan penyayatan daerah yang diinginkan dengan klik kanan pada Map 

topografi → Add → Profile → klik dari ujung sampai ujung daerah yang disayat 

pada peta geologi, maka tampilan sayatan akan muncul seperti Gambar L44.  

Gambar L44. Tampilan penyayatan daerah penelitian 
 

7. Gabung antara hasil sayatan dengan kurva yang diolah pada Excel menggunakan 

software Power Point ataupun Microsoft Word hingga seperti pada Gambar L45. 

 
Gambar L45. Penggambungan sayatan dengan kurva kedalaman H/V 
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H. Pengolahan H/V Rotate 

 

1. Buka data pada Geopsy seperti pada langkah 1- 3 pada Lampiran 4. 

2. Klik H/V rotate pada toolbar → Select → Load → pilih file windowing dalam 

format .hv → klik Start. 

 

Gambar L46. Tampilan menu H/V rotate 

3. Muncul kurva H/V rotate seperti pada Gambar L47, kemudian simpan kurva 

dengan cara klik Format → Save Layers → pilih tempat untuk disimpan → Save.  

 

Gambar L47. Tampilan kurva H/V rotate pada Geopsy 
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4. Buka kurva yang telah disimpan pada software Excel → pilih nilai amplifikasi 

terbesar beserta nilai azimutnya 

 

Gambar L48. Data kurva H/V saat dibuka pada Excel 

 

5. Buka software Rockwork → input data pada tabel dengan ketentuan : kolom 1 

adalah nilai azimut dan kolom 2 nilai amplifikasi seperti pada Gambar L49. 

 

Gambar L49.Tampilan awal pengisian datasheet diagram rose 

 

6. Untuk menampilkan diagram rose, klik Linears pada toolbar → Rose Diagram 

→ From Bearing → Proses. 
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Gambar L50. Tampilan diagram rose setelah diproses 

7. Simpan hasil diagram rose dengan cara pilih File pada menu → Export → 

simpan dalam bentuk .jpg 

8. Lakukan langkah 1-7 pada semua titik penelitian. 

9. Gabung diagram rose dengan peta geologi beserta garis sesarnya menggunakan 

software Microsoft Word ataupun Power Point seperti pada Gambar L51. 

Gambar L51. Tampilan peta diagram rose 
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Lampiran 12 

Dokumentasi Penelitian 
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